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1 Introduction 

With Report, you create report views for versatile analyses. Display figures as a table or 

chart, print the view or export as Microsoft Excel, Microsoft Access, XML, HTML or CSV file. 

Report templates for a data record type are available by clicking on the Report button in 

the upper right of the toolbar in the data record window or in a list. 

Create your own Crystal Reports documents with the Crystal Reports Designer (additional 

paid software not included in CAS genesisWorld or the Report module) and export them 

as a Crystal Reports, PDF, CSV, Microsoft Excel, Microsoft Word, RTF or XML file.  

Template reports created with Crystal Reports support an automatic report dispatch. 

Schedule and plan with the timeline view and board view in the Web Client. 

Define customer dashboards in the Management Console to display an overview of 

fields, figures and links for individual data records. 

1.1 Feature overview 

 Report views (Desktop Client and Web Client) 

 Interactive analysis table and graphic charts 

 Group by text fields, date (year, quarter, month, week, day), postal code area 

(1st/2nd/3rd character), individual levels of hierarchical input helps and link type in 

any desired nesting depth 

 Selection of link types, multilevel analysis of primary links, aggregation and dossier 

mode for comparing different data record types 

 Require the presence or absence of certain links as a filter criterion 

 Formula editor with access to fields and input help items of selected data records 

 Create Crystal Reports documents (in the Desktop Client with selected data only) 

 Report templates (Desktop Client and Web Client) 

 Detailed analyses of selected data records in the interactive report view 

 Use Crystal Reports for extensive and detailed reports 

 Automatic report dispatch 

 Planning views (Web Client) 

 Board view and timeline view 

 Customer dashboard (Desktop Client) 

 Overview of data record fields, measures and links 
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1.2 Specifics with modules and integrations 

When using Report, you have to consider certain specific characteristics in combination 

with other modules and integrations. 

The most important features and limitations are described where they apply in this user 

guide, especially specifics when using CAS genesisWorld Web. 

For an overview, see the Report page under Working with several modules in the 

English version of hilfe.cas.de. 

1.3 Note on receipt items 

If you are using ERP.connect or Easy Invoice, receipts and receipt items are available. 

Please note that in the English language version, receipt items used to be displayed as 

"document items" in former versions. Older databases still use this name. 

https://hilfe.cas.de/CgW/en/Mehrere_Module_einsetzen/index.htm#mme_report_und_andere.htm
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2 Creating and configuring report views 

The following chapter describes how to create report views and how to specify in a report 

view’s properties the selection of data, the visualization, and connection to Crystal Reports. 

2.1 Creating a report view in the program navigator (page 10) 

2.2 Configuring a report view (page 10) 

2.3 Data records (page 11): data records, fields and links to be analyzed  

2.4 User data (for time records and expenses, page 26): include employee address data 

and filter by address fields (e.g., "Department is equal to Accounting") 

2.5 Time records (page 27): working hours per day, week, month, quarter or year 

2.6 Resource plans (page 29): group ETC by date 

2.7 Additional fields (for receipts and records with currency fields, page 31): apply 

statistic factor to receipt sums and convert monetary amounts to base currency 

2.8 Billing (for time records, expenses and external services, page 32): configure 

Billing menu (prepare time records for billing, create items for time records, expenses and 

external services, create vendor credits and bill time records) 

2.9 Primary links (when active, page 33): include data from the primary address, project 

and/or job, supporting multiple job levels (flexible job hierarchy) 

2.10 Last field change (with required other right, page 34): analysis of date and time 

of the last change in selected fields 

2.11 Visualization (page 35): selection of grouping fields, display values and filter values. 

Default settings of the view when opening it 

2.12 Using and editing a Crystal Reports Design (page 40): exporting data from the 

report view to Crystal Reports and embedding generated reports 

2.13 Crystal Reports (page 43): exporting and archiving Crystal Reports documents 

2.14 Crystal Reports: Supported Versions and Features (page 44): supported versions 

and features of the Crystal Reports Integration 

2.15 Crystal Reports: Limitations (page 44): limitations of the Crystal Reports 

Integration 

2.16 Crystal Reports: Connecting datasources manually (page 45): instructions for 

manually connecting the datasource with Crystal Reports 2020 or in case of an error 

Note 

Creating and modifying report views is only possible in the Desktop Client. 

However, once created, report views are also available in the Web Client with support 

for most features. For details, see chapter "4 Report views in the Web Client", section 
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"4.9 Differences to the Desktop Client" on page 68. 

Creating new report views and editing the properties of existing report views both 

require a Manager license for the Report module. 

Without a Manager license, it is not possible to create any new report views or change 

the properties of existing report views. 

2.1 Creating a report view in the program navigator 

You insert the view in your program navigator in the following way. 

 Right-click on the desired place to call up the context menu. 

 Select Create new view. The view wizard opens. 

 Select Report view. Then click Next. 

 Enter the desired name for the view. Then click Next. 

 Specify all further settings of the report view, as described in the following sections. 

 Confirm the creation of the report view by clicking Finish. 

2.2 Configuring a report view 

To edit a report view, right-click on its navigator node and select Properties from the 

context menu. 

You can edit report templates in the template selection, which you open via the Report 

button (see chapter "5 Using report templates" on page 69). 

You make the following settings when creating or editing report views or templates. 
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2.3 Data records 

In the Data records tab, you select the data records and fields to analyze. 

Depending on the data record types you select, you may select additional data and enter 

settings on additional tabs. These are listed on the pevious pages. 

 

2.3.1 General 

You select the core data records and associated fields with the following settings. 

 Data record type: Here you select one of the visible data record types. In addition, a 

number of data record types which do not have their own data record windows and a 

number of options for the analyses of certain links are available here. 

 Companies and contacts persons: Filter by address type. You can add associated 

contacts to companies and vice versa. Selecting a link type isn’t required. 

Please note that these options never select individual contacts. 

Alternatively, you can filter by address type using the is Company (companies and 

individual contacts) and is Contact (contact persons and individual contacts) fields. 
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 Employees and associated data records: Select addresses linked to users. You can 

add data records in which a linked user has been entered in a text field using the 

additional options for selecting the link type. 

 Time records/expenses and employees’ addresses (Project/Helpdesk): When 

you select time records or expenses, linked with addresses, or the other way around, 

the User – Time records or User – Expenses link type will be available. It assigns to 

each time or expense record the associated user’s address, provided the user has 

been assigned an employee address. 

 Inxmail distribution lists and addresses (Inxmail Professional Integration): 

When you select distribution lists, linked with addresses, or the other way around, 

the Inxmail categories Recipient, Unsubscribed and Declined will be available in 

the Link name field. 

 Campaign statistics (Marketing – Only with Microsoft SQL database, not 

supported with Oracle databases): You can analyze campaign statistics discretely 

or in connection with campaigns via Include links. 

 Product items: When you select opportunities, you can analyze associated product 

items via a link query. Please note that product items are distinct from project items 

available with the Project module, which are just called items. 

 Items and appointments (Project): When you select (project) items, you can 

include associated appointments via a link query and vice versa. 

The link is called Item for appointment. 

 Items and products (Project): When you select (project) items, you can include 

associated products via a link query and vice versa. 

 Items and time records/expenses/external services (Project): When you select 

(project) items, you can include time records, expenses or external services that were 

billed via an item via a link query and vice versa (see Project user manual). 

The links are called Billed time records/expenses/external services – Billing item.  

 Prices and discounts (Sales pro and Project): Prices and discounts represent 

special terms for select customers and are available with Sales pro or Project. 

Links to addresses can be included with the Include links feature.  

 Receipts and receipt items, formerly called "document items" (ERP.connect / 

Easy Invoice): When you select receipts, you can include associated receipt items 

via a link query. Specify in the Additional fields tab whether the statistic factor 

should be considered for receipts and receipt items and whether monetary amounts 

in foreign currencies should additionally be converted to the base currency (see "2.7 

Additional fields" on page 31). 

 Original receipt and follow-up receipt (Easy Invoice): For receipts, you may 

include linked follow-up receipts (e.g., an invoice created for a sales quote). 
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 Cancellation document and cancelled receipt (Easy Invoice): For cancelled 

receipts, you may include the respective cancellation document and vice versa. 

 Items and order items (Project with Easy Invoice): You can include links between 

(project) items and associated order items (receipt items for receipts of the Order 

type) in both directions. 

 Order items and receipt items (Easy Invoice): For order items, you may include 

associated receipt items. To do so, select receipts with linked receipt items. Then add 

linked receipt items once more and select the associated link. 

 Receipt items and time records/expenses/external services (Easy Invoice): 

When you select receipt items, you can include time records, expenses or external 

services that were billed via a receipt item, or the other way around. Selecting a link 

type isn’t required. 

 Receipt items and addresses (Easy Invoice): When you select receipt items, you 

can include the addresses linked to the the associated receipts, or the other way 

around. Select the required link type. 

 Receipt items and products (Easy Invoice): When you select receipt items, you can 

include the associated product, or the other way around, via a link query. Selecting a 

link type isn’t required. 

 Status changes (Helpdesk): You may analyze status changes in connection with 

jobs via Include links. 

 Surveys and questionnaires (Survey): When you select a data record type for 

which questionnaire templates are available, or when you select surveys, associated 

questionnaires will be available for selection as linked data records (see section 

"Questionnaire" on page 24) 

 Preview: Here you open a list of the core data records currently selected with the 

settings Data record type, Filter, Participants and Include links. 

 Fields: Here you select the fields to analyze. For addresses, you also specify here 

whether pictures should be transferred to Crystal Reports and whether numbered 

address lines should be exported (as for mail merge documents).  

The exported fields are called "ADDRESS_ADDRESSLINE_", followed by "BUSINESS" for 

company address, "DELIVERY" for delivery address, "PRIVATE" for private address and 

"SAVED" for the address that was selected when the data record was last saved. 

The fields are numbered 1 to 7 respectively. "ALL" fields with all seven lines of each 

address are also available. 

 Filter: Here you select filter conditions to further limit the selected data records (e.g., 

Sector is equal to banking.) 
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 Filter by current user: The "Current user" placeholder represents the current user. 

For example, a report view for time records using the filter condition User name is 

equal to "Current user" displays the current user’s time records. 

 Participants: Here you select the users whose data records are included in the analysis 

when analyzing user sensitive data record types. 

2.3.2 Options 

Under Options, you specify whether link queries should be connected with OR and select 

the view format for the list. 

 Link subqueries with OR: If you have entered more than one link query in one of the 

Only data records with the following links or No data records modes, in the default 

setting, only core data records to which all of these link queries apply are included in 

the analysis. Select this option if all core data records to which at least one of the link 

queries applies should be included instead. 

 View format: Here you select the view format for the list. 

 Edit view format: Here you open the window View format for selecting and 

editing view formats. 

2.3.3 Calculations 

Under Calculations, you can define precalculated values and calculated fields. 

 Select precalculated values: Here you define precalculated values. 

A precalculated value combines several linked data records to one measure. For 

example, you may calculate the number of tickets for a support client or the sum of 

time records for a project. 

You either select the data records to process via the data record type, filter conditions, 

participants and link types or via an existing link query. 

When you select a link query, calculated fields defined in the query will also be 

available as base of the calculation. Precalculated values defined in the query won’t be 

available. Please note that data records will be counted only once even if a link query 

returns them multiple times via different links. 

Click on the Select precalculated values button in order to open the list of 

precalculated values. Here you create new precalculated values and edit, duplicate or 

remove precalculated values that have already been defined. 
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 Editing a precalculated value: To create or edit a precalculated value, the 

Precalculated value window opens. 

 

 Name: Specify an internal name here. Special characters and blanks are not allowed. 

The internal name may not be identical with another internal field name. The field will 

be available in Crystal Reports under this name. 

 Description: If desired, enter a description to display in the report view here. 
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 Select Use field from linked data record to select linked data records via data record 

type, filter conditions, participants and link types. 

 Linked data records: Select here the data record type of the linked data records 

from which the measure should be calculated. If desired, you may also enter filter 

conditions as well as select participants and link types to be regarded. 

 Value: Specify here whether the number of linked data records should be specified 

or whether to calculate the Sum, Minimum, Maximum or Average of all selected 

data records for the field. 

 Select Use field or calculated field from queries to select linked data records via a 

link query. 

 

 Available queries: Select the desired link query here.  

 Value: Specify here whether the number of linked data records should be specified 

or whether to calculate the Sum, Minimum, Maximum or Average of all selected 

data records for the field. 

When you select a link query, you may select from all available fields of the selected 

data record type regardless of the fields selected in the query, as well as from any 

calculated fields defined in the query. 

Note 

For fields of the datetime data type, only the Minimum, Maximum and Average 

functions are available. 

For fields of the bit data type, only the Sum function is available. It returns the number 

of true values. 
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For text fields (char/nchar and varchar/nvarchar), only the Minimum and Maximum 

functions are available. They return the first or last item in alphabetic order. 

 

 Select calculated fields: Here you define calculated fields. 

You may assemble the desired function in a formula editor using functions and fields of 

the data records to be analyzed as well as calculated fields that have already been 

defined. 

Click on the Select calculated fields button to open the list of calculated fields. 

Here you may create new calculated fields and edit, duplicate or remove existing 

calculated fields. 

 

Notes 

Please note that calculated fields are calculated per data record. When summing up 

over groups in the report view, the calculations will therefore not be executed for the 

sums, but instead the results of the calculations for each data record that is included in 

the sum will be summed up. 

Please also note the following chapters on the formula editor: 

9 Data types in the formula editor (page 97) 

10 Functions in the formula editor (page 99) 

11 Operators in the formula editor (page 120) 
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 Edit calculated fields: To create or edit a formula, the Edit calculated field window 

opens. 

 

 Name: Enter an internal name here. Special characters and blanks are not allowed here. 

The internal name may not be identical with another internal field name. The field will 

be available in Crystal Reports under this name. 

 Description: If desired, enter a description to display in the report view here. 

 Result type and Format: Select here the desired field type. For floating point numbers, 

also select the desired format here. See chapter "9 Data types in the formula editor" on 

page 97 for more information about the available data types. 

 Float = floating point number, e.g., “1.25”, precision up to 15 digits total before and 

after the point (e.g., 7 digits before and 8 digits after the point). 

Format Decimal, Currency or Duration in PD / 24h days. 
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Note 

The number of decimal places you select for floating point numbers in the Decimal 

format affects the precision of calculations as well as the appearance of results. 

 

 Integer (range -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807) 

 Boolean value ("true"/"false") 

 String 

 String constants must be put in double quotes (e.g., "String"). 

 Concatenate string fields and constants with "+" (e.g., {Field} + "String") 

 Special characters (", \) must be preceded by a backslash character (\) if they 

should be part of the string (e.g., "\"Quote\"" or "C:\\Users"). 

 Line breaks can be inserted with "\n" (e.g., "Line1\nLine2"). 

 Date/Time (date/time fields or functions such as CurrentDate or EncodeDate) 

 Formula: By double-clicking entries of the displayed lists, you may insert fields, 

functions and operators in the formula. Alternatively you enter your formula in the 

displayed syntax using the keyboard. 

 Check formula: click on the Check formula button in the lower left to check 

whether the formula is valid. If errors are found, they will be displayed. The formula 

will automatically be checked for validity when you save it by clicking OK. 

 Available fields 

 Database fields, calculated fields & precalculated values of the current query 

 Database fields, calculated fields & precalculated values of superordinate queries 

 Database fields, calculated fields & precalculated values of any subordinate 

queries whose data records are aggregated with the current query 

 Date of the last field change for all fields selected under Last field change (see 

2.10 Last field change on page 34). 

 Record ID, for addresses User ID (can be used as parameter for the 

WorkingTimeForUser function, see page 114). 

 Values from input help options: for international input helps, you can insert the 

associated options independently from the client language. 

For instance, you can check the department of an address with this formula: 

{Addresses.Department} = {^Address.Department.Development} 

When executed in English, this formula checks for the "Development" value. In 

German, it checks for "Entwicklung" (if that is the translation entered under 

Database in the Mangement Console), and so on. 
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 Available functions: Under Functions you can see available functions and required 

parameters. Empty brackets mean that no parameters can be passed to the function. 

 Available operators: Supported operators are visible in the Operators list. 

2.3.4 Include links 

In addition to the selected core data records you may include links in the analysis here. 

 New query: Click New to add a query for links to other data records in your analysis. 

 New subquery: You can extend a link query with additional links or limit it via a link 

filter by introducing subqueries. Any settings made in subqueries relate to the data 

records of the associated link query instead of the core data records. 

 Select the link query to be extended with the mouse. 

 Click on the  arrow to the right of the New button to open the associated menu.  

 Select Subquery. 

 Edit query: By double-clicking an entry in the Include links list, or by selecting a list 

entry and clicking Edit you change an existing link query. 

 Remove query: Here you remove the selected link query. 
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Make the following settings for linked data records and links. 

 Include: Here you determine, whether the absence or presence of links effects the 

selection of the core data records. 

If you select either of the Only data records with the following links or Additional 

links options, selected fields of the linked data records, the time of linking and the 

name of the user who created the link will be available in the analysis. 

 Additional links: In this mode the linked data records supplement the already 

selected analysis data without effecting their selection. 

 Only data records with the following links: In this mode only core data records 

which are linked to one of the data records, specified here via one of the selected 

link types, are included in the analysis. 

 No data records: In this mode only core data records which are not linked to one of 

the data records, specified here via one of the selected link types, are included in the 

analysis. 

 General: Here you make all settings for the linked data records and the link types to be 

considered. 

 Data record type: Select the data record type of the linked data records here. 

 Preview: Here you open a list of the core data records currently selected with the 

Data record type, Filter and Participants settings. 

 Fields: Here you select the fields to be analyzed. For addresses you also specify here 

whether pictures should be transferred to Crystal Reports. 

 Filter: Here you select filter conditions to further limit the selected data records (e.g., 

Sector is equal to banking.) "Current user" represents the current user. 

 Participants: Here you select the users whose data records are included in the 

analysis when analyzing user sensitive data record types. 

 Link types: Three modes are available for including links: 

 All link types: This is the default setting for most data record type combinations 

and will include all links types. The inclusion of system links (links that won’t be 

displayed in the dossier) is optional. 

You can identify links with the Link name field. General links are listed under 

Connection. Primary links are separated in direct and indirect primary links. For 

example, a document with primary links to an address, project and job is linked 

directly with the job and indirectly with the address and project. 

 Only primary links: This is the default setting for time records, expenses and 

external services and will filter the links, such that only primary links are included. 

Other than with the All link types mode, direct and indirect primary links are not 

displayed separately in this mode. 
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 Only the following link types: Select the desired link types here. You may select 

from among any available link types except for general links, primary links and 

system links. 

 Options 

 Description: If desired, you specify a different name for displaying the data records 

in the report view. For example, this serves for distinction between two data sets of 

the same data record type. 

 Aggregate: Select this option for connecting the linked data records with the core 

data records via a distinct association. Each core data record for which at least one 

linked data record can be found will be extended with the linked data record’s fields. 

If a core data record has more than one link matching the query, the first linked data 

record that can be found will be selected, ignoring any other matching links. 

 Display together with other data record types in dossier mode: The dossier 

mode combines data records from different first level link queries in a shared 

Dossier query with shared fields. It includes all data records from all first level link 

queries selected for the dossier mode and will be available independently from the 

constituent queries and the fields selected in them. 

You may specify the fields Date, Subject, Category and Additional information in 

the Management Console in Miscellaneous > Dossier. You cannot modify the other 

dossier fields. Additionally, you can defined shared calculated fields for link queries 

in the dossier mode. To do this, you must add the desired calculated field to each 

sub query for which it should be calculated. The same entry must be used in the 

Description field and the Make calculated field available in dossier mode option 

must be selected each time. For queries in the dossier mode for which the calculated 

field hasn’t been defined, it will automatically acquire the NULL value. 

When exporting, the internal name of a shared calculated field for the dossier role is 

DOSSIER_FORMULA_[FIELD NAME]. 

When you are using a Crystal Reports Design, the data record type icon will be 

available in Crystal Reports as a BLOB field called DOSSIER_GWDATAOBJECTIMAGE. 

 Count: the number of all data records selected for dossier mode. 

 Data record type: the data record type, for example, task or appointment. 

 Date: the sorting field selected in the dossier settings. 

 Start: the start date of the data recod. The used date field is not selectable. 

 End: the end or due date of the data record. The used date field is not selectable. 

 Created on: time of creation. 

 Created by: the user who created the data record. 

 Changed on: most recent change. 
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 Changed by: the user who has made the last change in the data record. 

 Subject: the subject field selected in the dossier settings. 

 Type/Status: the fields Type and Status of the data record. 

 Category: the category field selected in the dossier settings. 

 Participants: the Participants field for user sensitive data record types. 

 Keywords: the Keywords field of the data record. 

 Notes: the notes field of the data record. For archived e-mails the content. 

 Additional information, additional information 2, additional information 3: 

The first three fields selected in the dossier settings as Additional information. 

 Link subqueries with OR: If you have entered more than one sub-query in one of 

the Only data records with the following links or No data records modes, in the 

default setting, only linked data records to which all of these link queries apply are 

included in the analysis. Select this option if all linked data records to which at least 

one of the sub-queries applies should be included instead. 

 View format: Here you select the view format for the list. 

 Edit view format: Here you open the window View format for selecting and 

editing view formats. 

 Calculations: Here you define precalculated values and calculated fields. The same 

features are available here as for core data records (see "Calculations" on page 14). 

 Companies and contact persons: If you have selected addresses as core data records 

or as linked data records, you determine here whether a company and associated 

contact persons should be treated as one address in the link analysis. 

 Normal: The default setting considers only links of explicitly selected addresses. 

 Do not include contact person links: include only links to selected companies and 

companies of selected contact persons. Links to contact persons won’t be included. 

 Company dossier: This setting includes, in addition to links of selected companies 

and contact persons, company-wide links of any other addresses which can be 

associated with a selected address. 

For selected companies, this includes the links of any associated contact persons. 

For selected contact persons this includes the links of the associated company and 

of all other contact persons associated with that company. 

 Corporate group dossier: This setting works like the company dossier but includes 

company-wide links of any companies directly or indirectly subordinate to a selected 

company or the company of a selected contact person in the Company group view. 
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 Questionnaire: Options for selecting a template, questions and the analysis mode will 

be displayed when you select Questionnaire as data record type. 

 

 Template: By default, the All templates entry is selected here. 

Alternatively, you may select the desired template.  

 Template/Survey: For questionnaires belonging to addresses or surveys, surveys 

will be available for selection in addition to templates. In this case, select the default 

option All templates and surveys if you don’t wish to filter by template or survey. 

Alternatively, you may select the desired template or survey. 

Please note that when selecting surveys, you may also determine the survey or 

surveys to include via the associated filter settings. 

 Questions: If you have selected a specific template or survey, you may select 

sections and questions here. By default, all sections and questions are selected. 

 In the Treat question/answer pairs like linked data records mode, you may group 

by section, type of question, question text, answer, achieved and maximal score and 
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by all questionnaire fields. The number of questionnaires, questions and answers as 

well as the maximal score of questions, the achieved score of answers and the total 

score of the questionnaire are available as display values. 

 In the Treat questions like fields mode, you may group by the answers or scored 

points of individual questions and by all questionnaire fields. 

The number of questionnaires, the achieved score of individual answers and the 

total score of the questionnaire are available as display values. Also, in this mode, 

the answers and score for all questions are available under Calculated fields in the 

formula editor for calculated fields for questionnaires. 

If you select All templates or All templates and surveys, this mode won’t be 

available.  
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2.4 User data 

The User data tab will be displayed when expenses or time records are included in the 

analysis as core data records, or as linked data records. Here you extend the selected data 

records with fields from addresses associated with users and filter them by these 

addresses. 

 

 Filter by corresponding employee data and/or add address fields: Select this option 

if you wish to add filter conditions for addresses which are associated with the users of 

the expenses and/or time records, or if you wish to include fields from these addresses 

in the analysis. In the group field menus the user data are available among the fields of 

the corresponding time records and/or expenses. 

 Filter: Here you specify filter conditions to exclude expenses and/or time records of 

users whose addresses do not satisfy the conditions from the analysis. 

The "Current user" placeholder represents the current user. 

 Fields: Here you select the fields from employees’ addresses which should be 

included in the analysis. 
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2.5 Time records 

The Time records tab will be displayed when time records are included in the analysis. 

Here you specify whether the participants’ working hours per day, week, month, quarter or 

year should be calculated. 

 

 Calculate working hours for time records: Select one of these options to include the 

work time enterered for users in the report. 

If available, the current working hours as entered in the Management Console in Time 

record > Working hours are used. 

For an employee whose working hours were not entered in the Management Console, 

the working hours entered in the user settings on the Calendar tab are used. For each 

participant of time records in the analysis, the sum of working hours in each interval 

selected here is calculated. 

This value is associated with exactly one time record in the interval. No working hours 

are associated with any other of the user’s time records. 

In the Configuration window the working hours of the selected intervals are available 

for selection as display values. 
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Notes 

The working hours are only displayed correctly if all rime records of a data group lie in 

the same interval for which the working hours were calculated. If you group by weeks, 

for example, the entered working hours are only displayed correctly if you have selected 

Each week. 

If you group time records of a user in an interval by another feature, the working hours 

are only displayed in one group. In the other groups the working hours are displayed as 

zero. This ensures that the group sum displays the correct working hours. The working 

hours are only displayed in an interval if the time record with which they are associated 

is not hidden due to a filter. In intervals in which a user has not recorded time, no work 

time is displayed. 

The Report data list shows for each user and interval with which time record the 

working hours calculated for that interval are associated. 



Report   Creating and configuring report views 

29 

2.6 Resource plans 

The Resource plans tab will be displayed in reports for resource plans (root or linked). 

 

 With Group ETC by date, one Resource plan detail record per week during the 

remaining duration of each current resource plan will be included with these fields: 

 Resource plan detail.Start (Monday of the respective week)  

 Resource plan detail.ETC (weekly ETC proportion)  

Restrict display period speeds up the calculation of ETC values per week and refers 

only to resource plans that are completely or partially in the future. 

2.6.1 Workload distribution 

For past resource plans with automatic distribution, a single detail record will be included 

with Start equal to the week of the associated job’s end and the resource plan’s full ETC. 

For past resource plans with manual distribution, associated remaining ETC values will be 

displayed where they have been entered, with month values being assigned to the last 

week of the associated month.  

In the current month, automatically distributed workloads and month values will be 

distributed equally over the remaining weeks, starting with the current week. 
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2.6.2 Overbooking 

With automatic or monthly planning, if an overbooking occurs in any week, that is, if the 

total of associated time records exceeds value planned for that week, the difference will 

successively be deducted from the remaining weeks starting with the last week of the 

month (for monthly planning) or the job duration (for automatic planning), and going 

backwards. 

Example: a job spans three weeks, starting with the current one. A total ETC value of 3 pd 

results in 1 pd per week. If 2.5 pd worth of time records are now entered in the first week, 

this results in a difference of 1.5 pd. This difference is first deducted from the last week (1 

pd – 1.5 pd = 0 pd, remainder 0.5 pd). The remainder of 0.5 pd is then deducted from the 

second week. The resulting ETC spread over three weeks is 0 pd, 0.5 pd, 0 pd. 

2.6.3 Filter conditions for resource plans 

You can adjust the view with filters, such that completed resource plans are no longer 

displayed. To do this, filter by ETC or Status:  

 ETC – greater – 0 hrs, 0 mins or 

 Status – not equal – Completed 

Use a date filter for linked jobs instead (e.g., End – greater or equal – "Today") to 

exclude past resource plans (in Only data records with the following links mode). 

However, please note that this can exclude open resource plans when a job has ended and 

isn’t extended while associated resource plans haven’t yet been completed. 

2.6.4 Hourly rates, costs and turnover 

With Make the "Internal hourly rate" and "External hourly rate" fields available, the 

following fields are also available per resource plan and resource plan detail: 

 Resource plan.Internal hourly rate (corresponding to job type) 

 Resource plan.External hourly rate (corresponding to job type) 

 Resource plan detail.Planned costs (ETC * internal hourly rate) 

 Resource plan detail.Planned turnover (ETC * external hourly rate) 

2.6.5 Resource plan details in Crystal Reports 

Resource plan details are available in Crystal Reports with all listed fields. 
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2.7 Additional fields 

The Additional fields tab will be displayed when you select one or more data record 

types with currency fields: Opportunities and product items, projects and items, receipts 

and receipt items, service agreements and product uses as well as any data record types 

with custom currency fields created in the Database area of the Management Console. 

 

 For receipts and receipt items, you specify here whether associated currency and other 

number fields should be weighted with the receipt’s statistic factor (1 for invoices, -1 

for credit notes and cancellations, 0 for sales quotes and delivery notes). 

This applies to any fields of the decimal, float and int types exept for the receipt fields 

Tax rate, Exchange rate and Due days as well as the Statistic factor itself. 

 You also determine here whether currency fields should be converted to the base 

currency. In this case, an additional currency field for the conversion to the base 

currency will be available for each currency field. 

 For receipts, you enter the respective exchange rate in the General tab of the 

associated data record window. 

 For all other data record types, you enter exchange rates per currency in the 

Miscellaneous area of the Management Console, under Currencies (see "8.2 

Settings in the Miscellaneous area – Currencies" on page 96). 
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2.8 Billing 

The Billing tab will be displayed when time records, expenses or external services are 

included in the analysis. Here you specify which features will be available in the Billing 

menu in the report view’s toolbar and how exactly those features will operate. 

If you don’t activate any features of the Billing menu here, the menu will not be available 

in the report view. 

 

The individual settings and features are described in the Project user manual. 
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2.9 Primary links 

The Primary links tab is displayed when primary links are active and available for at least 

one selected data record type. 

Here you extend the selected data records with fields of their primary links. The selected 

primary links will be determined for every data record for which primary links are available. 

 

 Primary address, primary project, primary job: By clicking in the respective boxes, 

determine which primary links should be included in the analysis. 

 Fields: Click here to select fields for the selected primary link. 

 Transfer fields from view format: Here you adopt the fields of the selected view 

format. 

 View format: Here you select the view format for the list. 

 Edit view format: Here you open the window View format for selecting and 

editing view formats. 

 Flexible job hierarchy: Select this option to analyze multiple job levels. If desired, also 

state the number of job levels you need in the Visualization tab for grouping. In the 

report view, all job levels are available with the Flexible job hierarchy setting. 
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2.10 Last field change 

In the Last field change tab sheet, you select fields for which you wish to analyze latest 

changes. 

In the report view, grouping fields will be available for the year, quarter, month, week and 

day of the last change.  

In addition, the date of the last change will be available as display value. 

 

 Select fields: Here you open the selection of available fields. Select the desired data 

record type to the top left in the Select fields window. Then select all desired fields. 

You may select several fields of different data record types to analyze the last field 

change. 

 Reset fields: Here you remove all fields from the selection. 

Note 

These settings are only available with the Report: Analyses of the last field change 

right. To assign this right to a user, open the Management Console and switch to the 

User Management area. The right is available for selection in the properties of a user 

under Other rights. 
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2.11 Visualization 

In the Visualization tab you specify the appearance of the report view. The view’s fields 

are determined when switching to this tab which involves a short waiting interval. 

 

The list shows fields to display, to group, or to filter by. 

 Available Fields 

 Selected fields of the core data records 

 Selected fields of linked data records 

 Link type, time and creator of the link 

 When using the dossier mode, shared dossier fields of the data records. 

 User description User name (long) and selected fields of addresses associated with 

users for time records and expenses; calculated working hours for time records 

 Selected fields of core data records’ primary address, project and job 

 Function fields Deviation, Deviation %, % column and % row to display deviations 

and proportions in groupings. 

 When you select resource plans and activate the associated Group ETC by date 

option, the ETC (Sum), Start(Years), Start (Quarters), Start (Months) and Start 

(Weeks) fields will be available to display the ETC and group it by date. 
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 Insert field: To insert a new filter, group or display field, drag it to the corresponding 

target panel in the Visualization tab by using your mouse. Alternatively, click on the 

field, select the desired target panel in the menu below the field list, and click Add as. 

 Remove field: To remove a field from the view, click it, hold the mouse button and 

drag it away from the functional panels. Alternatively, you can open the associated 

context menu by right-clicking on the field and by selecting Delete. 

 Filter: Fields in the filter panel at the very top of the report view are connected with a 

menu displaying all values of the selected field. Each value can be selected in order to 

hide the associated data records. 

You may filter and group by any fields of the following data types: 

 bigint, bit, char/nchar, datetime (filter and group only by year, month, quarter, week 

or day), int, smallint, varchar/nvarchar 

 Displayed data: The fields in the upper left below the filter panel are displayed as 

values in the view. By default the number of data records in a group Count is selected 

for display. Analyses covering different address types also offer a Company count. In 

addition, any number and date fields are available. Duration and currency formats are 

displayed in the view. 

Note on time records 

When you select one of the time record fields Internal hourly rate, External hourly 

rate, Actual costs or Actual turnover, they will automatically be determined for all 

time records in which these fields are empty because the time records haven’t yet been 

billed. 

The hourly rates depend on the time record’s User and Type. Different hourly rates may 

have been entered for certain customers and projects. 

The valid internal or external hourly rate, multiplied with the recorded Actual working 

time or the externally billable Charged working time, yields the Actual costs or the 

Actual turnover. These values are calculated with a precision of 4 decimals and 

displayed rounded to 2 decimals. When time records are billed, these values are stored 

with a precision of 4 decimals. 

When you export data or pass data to Crystal Reports, the automatically determined 

values will be transferred. 

 

The default calculation function for all fields except for date/time fields is the Sum of a 

group (e.g., total hours recorded for a project). 

The default calculation function for date/time fields is the Minimum (earliest date). 

To add or remove a calculation function, right-click on the field to open the context 

menu. Select the desired options from the context menu’s Function sub menu. 
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The following calculation functions are available for fields depending on their data type: 

 Sum, Minimum, Maximum, Average: supported for all fields of numeric types 

(bigint, int, smallint, tinyint, decimal, float and money). 

 Minimum, Maximum, Average: supported for date/time fields (datetime). 

To display deviations and proportions in groupings, the function fields Deviation, 

Deviation %, % column and % row are available. Drag the desired function field to the 

right of a display value field to display deviations or proportions for that field. 

 Deviation: each column group’s absolute deviation from the previous one. 

 Deviation %: each column group’s percentual deviation from the previous one. 

 % column: each row’s percentual proportion of the column’s total. 

 % row: each column’s percentual proportion of the row’ stotal. 

 Grouping column / row: These fields define the groups which are broken down along 

both axes of the analysis table. You may group by all fields by which you can also filter 

(see "Filter" on page 36). 

 Groups for date fields: For each date field, six group fields Year, Quarter, Month, 

Week, Day and Week day are available. 
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Group members are distinguished only by the specified part of date. For this reason, 

select Year first in analyses spanning multiple years. When grouping by Day in 

analyses spanning multiple months, select Month first. 

 Groups for postal code fields: You group postal code fields by the first character, 

the first two or the first three characters. To do this, succesively select the group 

fields Postal code (1. Character), Postal code (2. Character) and Postal code (3. 

Character). 

 Groups for product versions: In the report view, a group field is available for each 

part of the version separated by a dot in the Version field in tickets and product 

uses as well as the Version from and Version to fields in FAQ documents. 

 Groups for areas: When the Area field is selected for jobs or documents, separate 

group fields will become available for each level of the selection tree defined for that 

field under Areas in the Helpdesk area of the Management Console. 

 Groups for hierarchical input helps: When a field with hierarchical input helps 

("Selection tree") is selected, separate group fields will become available for each 

level of the selection tree defined for that field in the Database area of the 

Management Console. 

Note 

Uninitialized fields of the bit data type are set to NULL in the database. 

Such fields are displayed as No, as if they were set to false in the database. 

 

 When opening the view: Here you select the display type of the report view upon 

opening as well as the elements displayed when opening the view. 

 Display evaluation table: Show report view as a table upon opening. 

 Show configuration in analysis view: Show field configuration together with the 

analysis table when opening the report view. 

This option is only available when the Load all selected fields option has been 

selected under Used fields (see next page). 

You can always display the field configuration once the report view is open. 

 Show chart: Show report view as a graphic chart upon opening.Please note that this 

requires at least one grouping field in the Desktop Client. 

 Settings for charts: Here you select the default chart types for the Desktop and 

Web Client. Additional chart types are available in the Web Client. You may select 

different chart types for both clients. If you select a chart type for the Desktop Client 

only, it will be used in the Web Client as well. 

 Display data records list: Show list when opening the report view. 
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 Settings for list: Here you select data record types for which lists should be 

displayed. You also specify which list should appear first, whether empty lists should 

be displayed and whether the number of data records in each list is given. 

 Expand levels: Here you specify how many grouping levels are expanded when 

opening the view. 

 Used fields: With the Only load those fields that are used for visualization option, 

only fields that are either used in the vizualization or in the selected Crystal Reports 

Design will be loaded when opening the report view or creating a report from the 

template. When displaying the configuration in the report view, any other fields 

selected in the view properties will be loaded and can be added to the view. 

In report views with link queries, the three link fields Link name, Created on and 

Created by will only be loaded directly with the Only load those fields that are used 

for visualization setting, if one of those fields is used as a display or grouping field in 

the view, or if the view uses a Crystal Reports Design for which the Links entry hasn’t 

been removed from the selection of data record types. 

 Limit display of text fields: Here you can specify a number of characters to which 

longer values of text fields will be shortened. The settings affect only the report 

view’s display as a table or chart. When you export data or pass data to Crystal 

Reports, text fields will always be transferred completely even with this setting. 

 Grouping of rows: With the Use compact grouping setting, the heading column of a 

sub-group will be displayed indented under the row header of its parent group. Due to 

the space-saving layout, more data can be displayed at once. This is the presetting for 

new report views. 

With the Use table grouping setting, the heading column of a sub-group will be 

displayed to the right of the row header of its parent group. 

 Subtotals: When you have selected several column grouping fields, you can determine 

whether sum columns should be displayed for expanded groups of the first level with 

the Display columns with subtotals option. 
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2.12 Using and editing a Crystal Reports Design 

In the default setting the interactive Analysis table is displayed, which you may configure 

in the Visualization tab. Select Use Crystal Reports Design to create a formatted report 

using Crystal Reports. 

 

 Use Report visualization: If you use a Crystal Reports Design, you can open the Crystal 

Reports Viewer from the analysis table to create a report in the embedded design from 

the selected data.  

You can switch between the Crystal Reports Viewer and the analysis table. Each time 

the Viewer is opened, a new report is generated from the data selected in the analysis 

table at that time. 

 Report visualization first: In the default setting, the analysis table is displayed first. 

 Crystal Reports first: With this setting, a report will be generated from all data 

selected in the report view. 

 Only display Crystal Reports: Deselect the Display analysis table option if only the 

Crystal Reports Viewer should be displayed instead of the analysis table. 

 Select design: Select the Use Crystal Reports Design option. Then click Select 

different design to create a new design or select an existing one. Any design which 

uses only data records that are also selected in the view will fit the current report view. 
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 New: Here you create a new empty design for the selected data structure. 

If desired, remove data record types from the selection. The data record types will be 

stored with the design. You may use it only with views and templates in which all of the 

now selected data record types are available. 

 Rename: Here you change name of the selected design. 

 Duplicate: Here you create a copy of the selected design. As when creating a new 

design, you may remove data record types from the selection to create the copy with 

less data record types. 

 Deactivate: Here you deactivate the selected design. It will continue to be available in 

views and templates which use it. However, it will no longer be displayed in the list if 

you don’t select the Display deactivated designs option. To assign it to another view 

or template you must reactivate it. 

 Import: Here you import a CAS genesisWorld report design file (*.gwd). It contains a 

list of used data record types and the embedded Crystal Reports Design file (*.rpt). 

 Replace .rpt file: Via the Tools menu in the context menu you may replace the .rpt 

file in the selected design. For this to work, at least one field from every data record 

type as well as from links, if used, must occur in the file’s datasource. 

 Export: Here you export the selected design as a CAS genesisWorld report design file 

(*.gwd). It contains a list of used data record types and the embedded Crystal Reports 

Design file (*.rpt). 

 Export .rpt file: Via the Tools menu in the context menu you may export the .rpt 

file without any additional data. This file may be opened and edited in the Crystal 

Reports Designer independently from CAS genesisWorld. 

 Display deactivated designs: Select this option to display deactivated designs and 

reactivate them if desired. 
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 Display designs for all data record types: In the default setting, only designs that fit 

the selected data structure are displayed. Select this option to display all active designs. 

 Edit design: With the Crystal Reports Designer and the Crystal Reports Designer 

Integration for CAS genesisWorld you can open the selected design here. 

Along with selected fields, you may also transfer data to Crystal Reports to edit the 

report in the interactive preview. 

 

If fields appear in the selected design which are missing from the view or template, 

these can then be added to the view or template or deleted from the design. 

 

Notes 

A design can be used in several views and templates. Changes will affect all views and 

templates using the design. 

When a report is created, fields used in the design will be selected automatically, even if 

they are not selected in the report view or template 

For compatibility reasons, the CAS genesisWorld datasource cannot automatically be 

connected with the Crystal Reports Designer 2020. See section "2.16 Crystal Reports: 

Connecting datasources manually" on page 45 for connecting the datasource manually. 
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2.13 Crystal Reports 

With the Use Crystal Reports Design option, the Crystal Reports tab is displayed. 

 

 Crystal Reports Viewer: Open report in Crystal Reports Viewer application. 

 Display group structure initially: Here you specify whether the group navigator 

should be displayed when the Crystal Reports Viewer is opened. 

 Document: Export report as a document. 

 Document format: Select the language for international input helps here. The client 

language will be used by default (database language for automatic dispatch). 

 Document format: Rich Text Format (*.rtf), Microsoft Excel (*.xls), Microsoft Excel 

spreadsheet (*.xlsx), CSV (*.csv), PDF (*.pdf) or Microsoft Word - editable (*.rtf). 

 Archive document in CAS genesisWorld: Select this to save the document as a 

data record and store its file in the archive. The created documents will be linked 

with the associated master data records of the report. 

 Use template: Select a document template here to transfer duplicated field 

values (setting in the Database area of the Management Console) from the 

associated data record window. The file stored with the template will be ignored. 

 Optionally, One document per master data record will be created. 
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2.14 Crystal Reports: Supported Versions and Features 

Report supports SAP Crystal Reports in version 2013 or newer in all editions (Standard, 

Pro, Developer and Advanced Developer). The associated features are available in CAS 

genesisWorld with the Crystal Reports Integration and the SAP Crystal Reports Runtime 

Engine for .NET Framework (32 Bit). Both components are integral parts of the CAS 

genesisWorld Client and Server installations. 

Without additional software, you can use the Crystal Reports Integration and the Viewer 

included in the Runtime Engine to view associated reports in CAS genesisWorld Clients 

(Desktop, Web and Mobile) and to create reports by schedule on the CAS genesisWorld 

Application Server. 

Opening template reports in the Crystal Reports Viewer (see "5 Using report templates" on 

page 69), automatically exporting them in various formats and scheduling the sending of 

reports in any of the supported formats requires no Report license or additional software. 

Editing Crystal Reports files in CAS genesisWorld requires a Report Manager license, the 

Crystal Reports Designer 2013 or newer and the Office program Microsoft Access 2013 or 

newer, both of which you must buy in addition to CAS genesisWorld and Report. 

For compatibility reasons, the CAS genesisWorld datasource cannot automatically be 

connected with the Crystal Reports Designer 2020. See section "2.16 Crystal Reports: 

Connecting datasources manually" on page 45 for connecting the datasource manually. 

2.15 Crystal Reports: Limitations 

A maximum of 255 fields from data records and links may be transferred to Crystal 

Reports. Please note that, in addtion to selected fields, this always includes the GGUID 

primary key field for each data record. 

Per text field (char/nchar, varchar/nvarchar), a maximum of 65,534 characters will be 

transferred. 

When editing a design, the total number of characters in text fields that are smaller than 

256 characters is limited to 4,000 characters (2,000 with CAS genesisWorld x13.1.3, x12.2.3 

and less recent versions) per report data record (i.e., per row in the Report data list). 

SQL expression fields in Crystal Reports Designs are not supported in connection with the 

Crystal Reports Integration. 

Parameter fields which require user input are only supported in the Desktop Client. The 

Web Client, mobile apps and server-side scheduled report dispatch only support reports 

that don’t require user input. 

The PDF export supports only TrueType fonts and TrueType collections. OpenType fonts 

und OpenType collections are not supported here. 
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2.16 Crystal Reports: Connecting datasources manually 

In some cases, opening a Crystal Reports Design may cause an error that prevents the 

automatic connection of the datasource (e.g., if a formula in the report uses a field that is 

no longer included in your datasource). 

Also, it is generally not possible to automatically connect the datasource with the 64 Bit 

Crystal Reports Designer 2020 for compatibility reasons. 

In these cases, a message will indicate that the automatic connection of the dabase failed. 

 

Click on Details to see more information about the message. The exact reason why the 

database couldn't be connected automatically will be displayed. 

 

Use the following steps to manually integrate the database. 

Click on Open Crystal Reports Designer and manually integrate the database. 

A window opens displaying the path to the transfer database. 
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Copy the path to the clipboard. 

 

Confirm by clicking on Next. 

The design will be opened in the Crystal Reports Designer. 

Open the Database menu and select Set Datasource Location. 
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In the lower section, click on the plus icon next to the Create New Connection node to 

open it. Then open the OLE DB (ADO) node below it in the same way. 

If associated data sources already exist, you also need to double-click on Make New 

Connection. 
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To connect a datasource with Crystal Reports 2020, select the Microsoft Office 12.0 

Access Database Engine OLE DB Provider and click on Next. 

If you are using an older version of Crystal Reports and are connecting the datasource 

because of an error, select the Microsoft Jet 4.0 OLE DB Provider instead. 

 

Note 

If the Microsoft Office 12.0 Access Database Engine OLE DB Provider isn't available 

for selection, the Microsoft Access database engine isn't installed. 

Search for "Microsoft Access Database Engine 2010 Redistributable" online. 

Download the 64 Bit installer and install it. 
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Paste the path you previously copied to the cliboard into the Data Source field. 

 

Click on Finish. 
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Both under Current Data Source and under Replace by, select REPORTTABLE and click 

on Update. 

 

The datasource will be connected and you can edit the Crystal Reports Design as usual. 

Notes 

When you edit the same design again, it will retain the selected datasource. 

As we cannot check this when opening the design, the error message will still be 

displayed when trying to connect the datasource with Crystal Reports 2020. You can 

ignore it in this case. 

Additionally, the path to the "CAS genesisWorld Crystal Reports Database.mdb" 

datasource in your Temp folder will be retained under My Connections. The same path 

is used for all designs for which the automatic connection fails. Therefore, you only need 

to go through all steps listed here once. For any subsequent reports, it is sufficient to 

select Set Datasource Location in the Database menu and replace the upper 

REPORTTABLE by the table of the same name listed below under My Connections, 

"CAS genesisWorld Crystal Reports Database.mdb", via Update. 
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3 Report views in the Desktop Client 

When you click on the corresponding node in the program navigator, the report view 

opens with the selected default settings. 

 

The following sections describe the features of the view in the Desktop Client: 

 3.1 Manager license and Client license (page 52) 

 3.2 View (page 52) 

 3.2.1 Table (page 53) 

 3.2.2 Chart (page 55) 

 3.3 List and selection in table and chart (page 56) 

 3.4 Editing, saving or resetting the configuration (page 56) 

 3.5 Refreshing the view (page 57) 

 3.6 Printing the view (page 57) 

 3.7 Exporting data (page 58) 

 3.8 Report with Crystal Reports (page 59) 

 3.9 Editing a Crystal Reports Design (page 60) 
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3.1 Manager license and Client license 

The following sections describe all features available in report views with a Manager 

license. With a Client license, the following features will not be available: 

 Context menu for a grouping fields (sorting by group size instead of by group name 

and hiding/combining of smaller groups via Top values) 

 Context menu for display values (function Sum/Minimum/Maximum/Average) 

 Change or Save the Configuration (remove or add grouping fields and display values) 

 Editing a Crystal Reports Design 

All other features will also be available with a client license, such as: 

 Limited regrouping of filter, display and grouping fields via drag-and-drop: 

 Within an area (filter, display values, grouping row, grouping column) 

 In between grouping areas for row and column 

 From a grouping area to the filter area and back 

Moving fields that are initially in the filter area to a grouping area is not supported. 

 Export (with the Export other right), create a Report with Crystal Reports 

 Bill time records and preparation for billing (with the Project module and writing 

permissions for the time record fields Internally/Externally billed on/by) 

3.2 View 

The report view supports two view types Table and Chart. Please note that charts can only 

be displayed with at least one grouping field in the Desktop Client. 

 View: Here you switch between both view types. 

The table can be configured via the functional panels and fields directly in the view and 

serves for configuring the charts. You can also export it in different formats or print it out. 
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3.2.1 Table 

The analysis table displays the set values and groups. 

 

The following features for modifying the view are available directly in the table. 

 Filter: All fields have a small arrow button to the right of the field name. Click on this 

button to hide data records with certain values in this field. 

A set filter is indicated by a black arrow. If you remove a field from the view, any 

associated filters will be deleted. 

 Sort: Click on a grouping field to reverse the sorting order for the associated group. 

This also applies when the group is sorted by display values. 

 Sort by display values: By default, groups are sorted by names. For example, when 

grouping by company names, associated values will be sorted by company names 

alphabetically. 

Via the context menu for a column or row header, you may sort a row or column 

group by the display values of the associated colummn or row instead. 

 

Via the Sorting sub-menu of the context menu for a grouping field, you may switch 

between sorting by group names (Field value) and display values. 
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When selecting a display value, the sorting last selected for it will be applied. 

If no sorting was selected for that value yet, the table will be sorted by the result row 

or column. 

 

 Top values: With the Top values feature, you may hide all values except for the first 

ones in your set sort order. To do so, select the Top values option in the context 

menu of the associated grouping field. With the Show others together option, the 

hidden entries will be combined in the Others group. 

 

 Group: Move group fields around by dragging and dropping them with your mouse in 

order to change the grouping order. Alternatively you change the position of a group 

field via the sub-menu Sequence in the associated context menu. 

 Expand sub-groups: Here you expand all sub-groups of a group. In the context menu 

you also have the option to expand all sub-groups for all groups of one level. 

 Hide sub-groups: Here you hide all sub-groups of a group. In the context menu you 

also have the option to conceal all sub-groups for all groups of one level. 

 Change column width: Click on the right border of a column header and drag the 

border to the desired position using your mouse. The result column width can’t be 

changed. Sub-groups must be expanded in order to adjust the width of their columns. 

 Options for display values: If you have selected multiple display values you change 

their sequence by dragging and dropping them with your mouse. Alternatively you 

change their sequence via the sub-menu Sequence in the associated context menu. For 

display values the context menu also offers the sub-menu Function. Here you select 

the calculation function for the display value: Sum, Minimum, Maximum or Average. 
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3.2.2 Chart 

Click on the View button or select the Chart option in the associated menu in order to 

display the analysis table in a graphic chart. Please note that charts can only be displayed 

with at least one grouping field in the Desktop Client. 

 The chart adopts all set groups and display values including their sorting order. 

 Expanded sub-groups are broken down. 

 Hidden sub-groups are not displayed. 

 

 Select presentation mode: in the menu on the far upper right you select the desired 

mode of presentation: Area chart, Horizontal bar chart, Line chart, Pie chart or 

Vertical bar chart. 

Additionally, layered area and bar charts are available. 
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3.3 List and selection in table and chart 

In the embedded lists, you see the selected data records and links. 

When you open the report view, the list displays at most 1000 data records. If more than 

1000 data records are included in the report view, you can load the missing data records 

by selecting them, as descibed under Selecting all report data. 

 Display/hide list: Here you display or hide the list. A separate list is displayed for each 

data record type. The Report data list shows all data records and links in the report 

view and relates them to each other. When exporting report data to Microsoft Excel or 

Microsoft Access, the result looks exactly like the Report data list. 

 Selecting data and resetting the selection in the table: Select cells of the analysis 

table in order to show only data records of the selected cells in the list. 

 Selecting a group: Click a row or column header or in the associated sum field in 

order to select all data records of the corresponding group. 

 Selecting a section: Click in a cell of the analysis table, hold the mouse button and 

drag the mouse pointer to another cell in order to select a rectangular section. 

 Making multiple selections: If you wish to extend an existing selection with other 

cells, hold the [Ctrl] key while you select the cells you wish to add. 

 Selecting all report data: Click in the sum cell to the bottom lower right in order to 

select all report data, reset the selection. 

 Selecting data in the chart: Click a chart segment in order to show only data records 

of that segment in the list. When the view is displayed as a chart, it is not possible to 

reset the selection. 

 View formats: You can select list view formats for the individual data record types in 

the report view’s properties. Switching to another view format in the view is possible, 

but this change can’t be saved. Modifying view formats in the report view and saving 

such changes is possible with appropriate rights. 

3.4 Editing, saving or resetting the configuration 

Via the toolbar in the report view you access the field list, save the configuration of the 

report view or reset it. 

 Configuration: Here you display or hide the field list. Using the field list you can add 

fields to filter or group by or to display (see "2.11 Visualization" on page 35). 

 Save configuration: Here you save changes made to the configuration in the view: 

 Filter fields (hidden values are not saved) 

 Group fields, sequence and sorting 

 Display values and associated calculation functions 
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This feature is only supported for report views and templates. Settings of reports placed 

with Form Designer can only be changed in the Management Console.  

 Reset: Here you load the settings from the view’s properties. 

3.5 Refreshing the view 

Refresh the view in order to adopt changes. 

 Refresh: Here you reload the report view. In the process all data records and links are 

read through again. 

3.6 Printing the view 

You can print out the analysis table and the charts. The Print option in the File menu is 

not supported here. Please use the Print button in the view’s toolbar for printing the view. 

 Print: Here you print the current view. The Print window opens. 

 Page layout: Here you specify the page format, the printing order, the borders and 

content positioning, the header and footer design and the scaling. 

 Print preview: Here you open the print preview for the report. In the preview, a variety 

of options are available for formatting the report. Please note that you can’t adjust the 

set column width in this view. The following formatting options are available here: 

 Editing the borders: In the print preview, you edit page borders with your mouse. 

 Table – format report (menu File > Format or the cog icon): 

 View: Here you display or hide the Filter, Displayed data, Grouping row and 

Grouping column panels, the buttons for the expanding of sub-groups as well as 

the lines and borders. 

 Behaviour: Here you display all column or row groupings. If these options are 

not selected, only the groups displayed in the report view are shown. 

 Formatting: Here you specify the appearance of lines and colours. 

 Style: Here you specify font and background styles. 

 Chart – format report (menu File > Format or the cog icon): 

 Behaviour: Here you specify whether the width should be adjusted to the page 

borders automatically. 

 Charts: Here you specify whether the background colour should be plain or 

transparent. 

 Menu Format 

 Title: Here you specify text and formatting of the title. 
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 Date and time: Here you specify the format for dates and times. 

 Page numbers: Here you specify the numbering format for page numbers and 

the number of the first page. 

 Fit to page: Here you switch between the original size that may be several pages 

and a version scaled to one page. 

 Background: Here you format the page background. 

 Saving and opening reports: In the File menu, you can save formatted reports as 

RPS files and open existing RPS files. In the RPS file, any set printing formats and all 

report data are stored. 

3.7 Exporting data 

The Export menu is only displayed if you have export rights. Here you export the anaylsis 

table or the selected report data. 

 Export report to Excel, as XML or as HTML: You are prompted to specify a name for 

the target file. The analysis table is transferred to the selected target format in its 

current configuration. 

Note 

For exporting a report view to Excel, two modes are available:  

The data-based mode faithfully transfers the view’s data structure to Excel and is better 

suited for processing the data. However, this mode is limited to a maximum of each 8 

row and column groups.  

The format-based mode faithfully transfers the view’s layout to Excel and isn’t suited as 

well for processing the data. However, this mode isn’t limited to each 8 row and column 

groups.  

When exporting duration fields (e.g., Actual of time records) in the format-based mode, 

you will be asked if you would like to export the fields as formatted text (in person days, 

hours and minutes) or as numbers (in 24 hour days). 

 

 Export report data to Excel, to Access, as XML or as CSV: The selected report data 

are transferred to a new excel spreadsheet, an Access database, an xml file or a csv file, 

as displayed in the Report data list.  

Duration fields will be exported as floating point numbers in 24 hour days. 
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3.8 Report with Crystal Reports 

The Report with Crystal Reports button is only available if you have embedded a Crystal 

Reports document in the report view as described in "2.12 Using and editing a Crystal 

Reports Design" on page 40. 

 Report with Crystal Reports: Here you create a Crystal Reports document from the 

selected data and the embedded design. 

In the report view’s properties, you specify in the Crystal Reports tab whether the 

report will be opened in the viewer or exported as a file and opened in the associated 

application (see "Fehler! Verweisquelle konnte nicht gefunden werden. Fehler! Ve

rweisquelle konnte nicht gefunden werden." on page Fehler! Textmarke nicht 

definiert.). 

 

 Export report: Here you store the report in a file. Among others, the formats RTF, Excel 

and PDF are supported. 

 Print report: Here you print the report. 

 Refresh: This button regenerates the report from the report view’s data. To reload the 

data from CAS genesisWorld, you have to close the Crystal Reports viewer via the 

Report view's toolbar, refresh the report view and reopen the Crystal Reports viewer. 

 Copy: Here you copy selected report objects to the clipboard. 
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 Toggle parameter panel: Here you access the report's parameter fields, if it has any. In 

this case, you can edit all parameter fields on the fly. 

 Toggle group tree: Here you access the group tree, if the reports has any groups. 

Select an item in the group tree to go directly to that group. 

Page navigation: Use the arrows pointing left and right and the associated editable 

field in order to switch between the report’s pages. 

 Find text: Click on this to search for text and/or numbers in the report. 

 Zoom: Click this button to specify the zoom factor. 

3.9 Editing a Crystal Reports Design 

With the Crystal Reports Designer and the Crystal Reports Designer Integration, you can 

open the Crystal Reports Designer directly from the report view. 

 Edit design: Here you open the embedded design with the selected data in the Crystal 

Reports Designer (see "2.12 Using and editing a Crystal Reports Design" on page 40). 

Notes 

A design can be used in several views and templates. Changes will affect all views and 

templates using the design. 

When a report is created, fields used in the design will be selected automatically, even if 

they are not selected in the report view or template. 

For compatibility reasons, the CAS genesisWorld datasource cannot automatically be 

connected with the Crystal Reports Designer 2020. See section "2.16 Crystal Reports: 

Connecting datasources manually" on page 45 for connecting the datasource manually. 
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4 Report views in the Web Client 

In CAS genesisWorld Web, you access report views via the Reports app and via list views. 

 4.1 Report views in the Reports app (page 61) 

 4.2 Report views with a Crystal Reports Design (page 62) 

 4.3 Report views for list views (page 63) 

 4.4 View sections (page 64) 

 4.5 Chart features (page 64) 

 4.6 Analysis table features (page 65) 

 4.7 List features (page 66) 

 4.8 Other view options (page 67) 

 4.9 Differences to the Desktop Client (page 68) 

4.1 Report views in the Reports app 

In the Reports app, you have access to report views in your Desktop Client navigator. 

 

First, your favorites will be displayed (see "4.8 Other view options" on page 67). Next, any 

other report views in your CAS genesisWorld Desktop Client navigator will be displayed. 

The selection is sorted alphabetically. You may limit the selection via the search field. 
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4.2 Report views with a Crystal Reports Design 

Instead of the interacive analysis table with chart and data record list described in the 

following sections, you can also display a Crystal Reports Design as a pdf or export it in 

one of the supported formats. 

 

You need to configure this in the view properties in the CAS genesisWorld Desktop Client 

(see section "2.12 Using and editing a Crystal Reports Design" on page 40 and following). 

With the Use Report visualization option in the view properties, you determine whether 

the analysis table should be available in addition to the Crystal Reports Design and if so, 

which should be the starting view. In this case, you can switch between both views via the 

action menu with the three dots at the top right of the report view. 

 

As the Crystal Reports Viewer isn't available in CAS genesisWorld Web, the report will be 

displayed as a PDF in your web browser with the associated setting, same as when it is set 

up for export as a PDF. With the buttons at the top right, you can download or print the 

report. Reports set up to be exported in other formats will be downloaded directly instead. 

Note 

Please note that filtering Crystal Reports Designs by a selection of data records in the 

analysis table as well as setting up and editing Crystal Reports Designs aren't supported 

in CAS genesisWorld Web. 
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4.3 Report views for list views 

 To open a Report view for the data records displayed in a saved list view, open the 

View menu and select the Report view option. 

 

Notes 

This feature is only available for saved list views listed under Views in the associated 

app, including combined list views. It isn't available for list views with a link filter or list 

views that are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

With Save changes, all settings will be saved and restored when next opening the view. 

Settings are saved per list view and user, such that other users can’t overwrite settings 

you have saved for a public view. 

For your own views, clicking on Save changes will also save changes you made to filter 

settings. For public views, you can only save changes made to filter settings in the 

associated navigator in the Desktop Client. However, changes you make to filter settings 

will still be applied when switching between the list, board, report and timeline views. 

Reopening the list view out of the app start will reset its filter. 

 

In the report view, you have access to the usual features and configuration options (see 

sections "4.4 View sections" to "4.8 Other view options" on page 64 to 67). 

With a Manager license, all fields of the associated data record type are available in the 

Field selection. Without a Manager license, all columns of the list view are available here. 
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4.4 View sections 

Report views in the Web Client are split up in up to three sections: 

 

 At the top left, a Chart is displayed. 

 Via Properties in the View menu at the top left, you can display or hide the chart 

and select the presentation mode (see "4.5 Chart features" on page 64).  

 At the lower left, the interactive Analysis table is displayed. 

 Without the chart, the analysis table takes the full height. 

 Without the list, the analysis table takes the full width. 

 At the right, the List of associated data records is displayed. 

 You may display or hide the list via the arrow button at ist left edge. 

4.5 Chart features 

You have access to the following features in the chart: 

 Filter list: Select a chart segment to display only associated data records in the list. 

 Via Properties in the View menu at the top left, you can display or hide the chart and 

select the desired presentation mode: 

 Area charts (area chart, discrete, stacked, spline, stacked spline, 100% stacked, 100% 

stacked spline) 
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 Horizontal bar charts (horizontal bar chart, stacked, 100% stacked) 

 Line charts (line chart, discrete, stacked, 100% stacked) 

 Pie charts (pie chart, doughnut chart, stacked doughnut chart) 

 Radar chart (filled radar chart, radar chart with lines, radar chart with points) 

 Vertical bar charts (vertical bar chart, stacked, 100% stacked) 

 More charts (funnel chart, pyramid diagram, scatter plot) 

The 100% charts scale row groups percentually. Different groups may be scaled 

differently. This way, the percentual distribution of column groups is displayed. 

4.6 Analysis table features 

The analysis table offers the same features for selecting fields, filtering, grouping and 

sorting as the Desktop Client. For views configured in the Desktop Client and opened via 

the Reports app, most of the configuration saved for the view in the Desktop Client will 

be applied in the Web Client (see "4.9 Differences to the Desktop Client" on page 68). 

Saving changes made to Reports app views in the Web Client is not possible. 

You have access to the following features in the analysis table: 

 Filter list: Click on analysis table cells to filter the right hand side list, such that it 

displays only associated data records. Hold the [Ctrl] key while clicking to add a cell to 

the selection or remove a selected cell from the selection. 

 Show sub-groups: An arrow on a group name field indicates that the group has sub-

groups. Click on the arrow to display or hide its sub-groups. 

 Sort by group name: Click on the arrow on a grouping field to sort by it or reverse the 

sorting order. 

 Sort by display value: Right-click a row or column header to open a context menu for 

sorting the table by the values in that row or column or to reset the sorting order. 

Select the sorting option again to reverse the sorting order. 

 Filter table: Click on the funnel icon on a grouping or filtering field to open a list of its 

values. Then select the values to display. 

 Display field names: Via Properties in the View menu at the top left, you can hide 

field names (column and row headers) to make better use of the space reserved for the 

analysis table.  

Please note that the Sort by group name, Filter table and Remove field features 

aren’t available while this mode is active. 

 Change filter fields, grouping fields and display values: Drag fields to the desired 

target areas in order to filter (topmost area), to group (above column or row headers), 

or to change display values (upper left corner of the analysis table). 
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 Add field: Via Field selection, you can select filtering fields, grouping fields and 

display values as well as the desired functions for the latter (Average, Maximum, 

Minimum or Sum). Fields are grouped by data record type. 

In report views opened out of the Reports app, this requires a Report Manager license. 

 Remove field: Right-click a filtering or grouping field or a display value and select the 

Hide field option to remove that field. 

4.7 List features 

You have access to the following features in the right hand side list: 

 Via the arrow button at its left edge, you display or hide the list. 

 In reports with multiple data record sets, select the data records to display in the menu 

above the list. In the Desktop client, in the view’s properties under Visualization, you 

can select to display the number of data records per list (Display data records list > 

Show number of data records in the tab). 

 For performance reasons, the list displays a maximum of 500 data records. Initially, all 

data records will be displayed, if within the maximum. Otherwise, the first 500 data 

records will be displayed. 

Click on analysis table cells to filter the list, such that it displays only associated data 

records. Hold the [Ctrl] key while clicking to add a cell to the selection or remove a 

selected cell from the selection. 

As without a selection, up to 500 data records will be displayed with an active filter. 

 Via the arrow button at the top right above the list, you open the associated data 

records in the extended list view, which displays up to 9,999 data records 

For reports opened via the Reports app, this list uses the view format configured for 

the associated data records in the report view’s properties in the Desktop Client. 

For reports opened out of a list view, the list uses the format configured for that view. 

 Click on a data record in the list to open it in the associated detail view. 
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4.8 Other view options 

You have access to the following other view options in the menu bar above the view: 

 In report views opened out of other views, you can switch to the following views here: 

 Board view 

 Map view 

 Timelie view 

 Here you reload the data without resetting any changes you made to the view such as 

grouping and filters.  

For report views opened out of the Reports app, you can also reload the data without 

resetting changes by refreshing via the browser. For reports opened out of a list view, 

refreshing via the browser has no effect on the data or settings. 

 In report views opened out of a list view, click there to edit the filter settings for the 

report view as well as the associated list, board and timeline view. 

Switching between these views will temporarily retain changes made to filter settings. 

When you reopen a list view out of the app start, unsaved changes made to the filter 

for the list and other associated views will be reset. 

For your own views, clicking on Save changes will also save changes you made to 

filter settings. For public views, you can only save changes made to filter settings in 

the associated navigator in the Desktop Client. 

 In report views with a Crystal Reports Design for which this has been activated in the 

view properties in the CAS genesisWorld Desktop client, you can open the respective 

other view, analysis table or Crystal Reports, here (see "4.2 Report views with a Crystal 

Reports Design" on page 62). 

 With export rights, you may export the analysis table and chart here: 

 Analyses table as Excel 

 Diagram as PDF 

 Diagram as PNG 

 Diagram as SVG 

 Here, you can add report views opened out of the Reports app to your favorites. 

In the Reports app, your favorites will be listed before other report views. 
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4.9 Differences to the Desktop Client 

The following Desktop Client features are not supported in the Web Client: 

 Configuration of view properties 

 Saving changes of filtering fields, grouping fields, display values and filters 

 Saving of sort orders and filters by group names selected in the view 

 Loading of sorting by field values 

 Changing the column width (automatically assigned as needed) 

 Table grouping (the compact grouping will always be used) 

 Subtotals (automatically displayed for groups that have more than one subgroup) 

 Field filters for data fields (e.g., Probability in % = 100). 

 Sorting by top values 

 Pie charts for column groups or multiple display values (only works with row groups) 

 Deviation, Deviation %, % column, % row function fields 

 Exporting the report data (you can only export the analysis table and the chart.) 

 Exporting duration fields like Actual of time records as numbers to Microsoft Excel 

(they will always be exported as formatted text, in person days, hours and minutes.) 

 Opening a Crystal Reports Design with a selection of data records (Crystal Reports 

Designs will always include all data records.) 

 Printing the view (you may use your browser’s print feature) 

 Prepare billing 
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5 Using report templates 

Use report templates to create report views and perfectly formatted Crystal Reports 

documents for one or more data records in the Desktop Client and in the Web Client. 

 5.1 Creating a report in the Desktop Client (page 69) 

 5.2 Creating a report for a single data record in the Web Client (page 70) 

 5.3 Creating a report for multiple data records in the Web Client (page 71) 

 5.4 Creating and editing report templates (page 72) 

 5.5 Defining favorites (page 72) 

 5.6 Editing a template (page 73) 

 5.7 Report records and automatic report dispatch (page 74) 

5.1 Creating a report in the Desktop Client 

Report templates for a data record type are available when clicking on the Report button 

in the toolbar of the associated data record window or a list. 

 Open the desired data record or select data records in a list. 

 Click on the Report button in the toolbar of the data record window or list. 

The Create new report window opens. 
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 Select the desired template and click on Create report. 

Depending on the template’s settings, one of the following actions is executed. 

 Create a report view 

 Create a Crystal Reports document (also available without a Report module license) 

 Open in Crystal Reports Viewer 

 Export in RTF, Excel or PDF format and open in the associated application 

 Export, store in Document Archive and open in data record window 

5.2 Creating a report for a single data record in the Web Client 

In the Web Client, you can create reports for a single data record in the detail view: 

 Click on the three dots at the top right to open the action menu. 

 Select Display report. 

 

 Select the desired report template. 

 

The Web Client supports the same actions here as the Desktop Client (see above). 

As for report views in the app, you can switch view modes (analysis table or Crystal 

Reports) via the action menu with the three dots for templates supporting this. 
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5.3 Creating a report for multiple data records in the Web Client 

Via list views, you can create reports to multiple selected data records. 

 To do this, first select the desired data records by checking the respective boxes in the 

first list column. 

 Then open the action menu by clicking on the three dots at the top right and select the 

Display report action. 

 

 This opens the template selection. Select the desired template here. 

 

The report will be created from the template with the previously selected data records. 

The Web Client supports the same actions here as the Desktop Client (see page 69). 

As for report views in the app, you can switch view modes (analysis table or Crystal 

Reports) via the action menu with the three dots for templates supporting this. 
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5.4 Creating and editing report templates 

Creating and editing report templates is possible in the Desktop Client only. 

In order to create or edit a report template, first open the selection of report templates for 

the desired data record type as described in the previous section. 

The following features for creating and editing report templates are available. 

 Create new: Here you open the Edit template window to create a new template. 

 Edit: Here you open the Edit template window to edit the selected template. 

 Duplicate: Here you create a copy of the selected report template. 

 Delete: Here you delete the selected report template. Before deletion you are asked to 

confirm. 

 Import: Here you import a report template from an XML file in order to transfer a 

report template from another database from which it was exported. 

 Export: Here you export the selected report template to an XML file. 

5.5 Defining favorites 

Report template favorites are supported in the Desktop Client only. 

You may define report templates as your personal favorites. This way they will be available 

directly in the toolbar of lists and data records in a menu. You open it by clicking on the 

little arrow to the right of the Report... button. 

 Open the context menu by right-clicking on the desired report template. 

 Select Add to favorites. 

The report template is now displayed in the Favorites list. You may remove it from the 

favorites via the context menu. 
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5.6 Editing a template 

Creating and editing report templates is possible in the Desktop Client only. 

You edit new and existing report templates in the Edit template window. 

 

In the upper section you specify the Name and Notes for the template. 

You may control access rights via Participants and External access. 

Report templates support all functions that are available in report views. 

Therefore, you make the same settings in report templates as in the properties of a report 

view (see chapter "2 Creating and configuring report views" on page 9). 

Since you select the data records for which a report is created via the data record window 

or list, the Data record type, Filter and Participants settings are not required. 

Report templates with a Crystal Reports Design can be used without a license for the 

Report module. In this case, however, the Report visualization isn’t supported. 
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5.7 Report records and automatic report dispatch 

You can automatically dispatch reports from templates with Crystal Reports Designs. 

Notes 

To send reports, you need to set up the notification and action service, including the 

associated e-mail account, and the service needs to be running (see "8.1 Settings in the 

Rules area" on page 95). 

Whenever a report is dispatched, it is generated anew from the selected report 

template. Changes made to report templates will therefore potentially affect previously 

created report records configured for automatic dispatch. 

Dispatched reports have the file type selected in the report template’s Crystal Reports 

tab. Reports created from templates without a selected file type will be sent as pdf files. 

5.7.1 Creating a report record 

To set up the report dispatch, first create a data record of the Report type: 
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A wizard with the following steps will open: 

 Select the data record type to create the report for (e.g., Time records). 

 Select a report template (e.g., List for time records). 

 Select filter conditions (e.g., Start is identical with "Last month"). 

 For user sensitive data records only: Select team settings for report recipients (e.g., 

Only personal data records). For user sensitive data records, team settings and 

associated access rights of selected recipients, in addition to selected filter conditions, 

control which data records (e.g., time records) will be included in the report. In the time 

record list example, each recipient would regularly receive a list of their own time 

records in the previous month.   

Once you’re finished selecting the report template and data records, click on Finish. 

5.7.2 Participants 

You will be asked whether you wish to adopt the participants of the template. The 

participants of the report record can access it to configure the report dispatch. 

Please note that the participants of a report record are not necessarily identical with the 

recipients of the dispatched report, which you select in the Schedule tab (see the 

following page). 

5.7.3 General tab 

In the General tab, you enter a Subject. This is useful in order to quickly identify different 

report records in a search result list or list view. 

Click  on Generate to create and display a preview of the report. Your access rights will be 

considered regarding the team settings selected for the report. 

Please note that reports for user sensitive data record types will potentially be different for 

each recipient, depending on access rights and team settings. 

5.7.4 Filter and Team tabs 

In the Filter and Team tabs, you can adjust the associated settings you originally made in 

the report wizard at any time (see top of page). 
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5.7.5 Schedule tab 

In the Schedule tab, you make all settings for the automatic dispatch: 

 

 Select Send report automatically to activate the automatic dispatch. 

Then click on Select to select users and groups.  

Enter E-Mail addresses, separated by commas (,) or semicolons (;) to add external 

recipients. Please note that restrictions to the selection of data records that apply due 

to team settings will apply for external recipients as well. They will receive the data 

records of the first selected user.  

For selected users and groups, the e-mail address entered in the Management Console 

will be used. Groups won’t be resolved. 

 Under Recurrence pattern, you select the period, time of day and for weekly or 

monthly dispatch the days of the week or day of the month to send the report. 

5.7.6 Change log tab 

As for other data record types, the Change log tab displays any changes made to fields 

and links of the report record. 

5.7.7 Dossier tab 

As for other data record types, the Dossier tab displays any links of the report record. 
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6 Planning views in the Web Client 

With the Report module, the following planning views are available in the Web Client. 

 6.1 Board view (page 77): Group data records by field values 

 6.2 Timeline view (page 82): Chronological order of data records 

6.1 Board view 

The following sections briefly outline the availability, visualization and features of the 

Board view, which is available in CAS genesisWorld Web with Report. 

 6.1.1 Licensing (page 77) 

 6.1.2 General (page 77) 

 6.1.3 View menu (page 79) 

 6.1.4 Properties (page 79) 

 6.1.5 Filter (page 80) 

 6.1.6 Interactions (page 81) 

6.1.1 Licensing 

When Report, Project or Helpdesk is licensed, the Board view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

6.1.2 General 

The Board view displays the grouping of data records by input help items of a field. 

Opportunities may also be grouped by the month of their end date. 
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With either of the associated licenses, you may open the view out of saved list views for 

any type of data records that have at least one field with input help items. 

The view is available for both standard and custom data record types. 

 To open a Board view for the data records displayed in a saved list view, open the 

View menu and select the Board view option. 

 

Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

When grouping by input help items, only field values that are actually available as input 

help items will be displayed. Data records with field values which are not or no longer 

available as input help items will be displayed as Not assigned. 

All settings, except for filter conditions, are automatically saved per list view and user 

and will be restored when next opening the view. 

For your own views, click on Save changes to save changed filter conditions. For public 

views, you can only save changes made to filter settings in the associated Desktop 

Client navigator. Unsaved changes made to filter conditions will be temporarily retained 

when switching between the list, board, report and timeline views. Reopening the 

associated list view out of the app start resets the filter. 
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6.1.3 View menu 

 Via the View menu, you can switch to one of the following views: 

 Map view 

 Report view 

 Timeline view 

6.1.4 Properties 

 In the Board view, you can edit the following Properties. 

 Use the following field for grouping: Select here a field with input help items, 

which will be displayed as columns for grouping the data records. Additionally, the 

Not assigned column will be displayed for data records without a field value and 

for field values that are not or no longer available as input help items. 

 Use the following type for grouping by Status: If you select the Status field 

for grouping and the status depends on the type, status assignments will only 

be displayed for a specific type, which you select here in this case. 

Items with other values in the Type field will not be displayed in this case. 

 Group opportunities by End (Month): You can group opportunities by the 

month of their end date. 

If you do, select the number of indvidual month columns to display under 

Number of columns months, beginning with the current month.  

Additionally, the following columns are available: 

 Not assigned (opportunities without an end date) 

 Until (opportunities with an end date before the current month) 

 From (opportunities with an end date after the last individual month column) 

In this view, you can change the months of opportunity end dates via drag-and-

drop to a month column or to the Until or From column: 

 The Until column assigns the previous month. 

 The From column assigns the first associated month. 

When you do this, the day of the month will usually stay the same, but will be 

set to the last day of the new month if required (e.g., when you move an 

opportunity from 08/31 to September, the new end date will be 09/30). 

 Display the following column values of the grouping: Display or hide columns 

for specific field values as well as the Not assigned column. 
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 Use the following field for the sorting: Select here a field for sorting records 

within a column. In addition to fields of the displayed data record type, you may 

sort by the first or second row as defined for that data record type in the App 

Designer with the 1. row and 2. row items. 

Click on the button next to the sorting field to reverse the sorting order. 

 Use the following field for the sum row: Select the number of cards or a field to 

display as sum in the header row here. 

 Offer currency fields in the base currency: When you select a currency field for 

the sum row (e.g., Total for opportunities), this option will be available to convert 

data records with foreign currencies to your base currency with column totals. 

This requires entering conversion rates from the base currency to all other used 

currencies under Currencies in the Miscellaneous area of the Management 

Console (see "8.2 Settings in the Miscellaneous area – Currencies" on page 96). 

Note 

This feature isn't supported for fields of the money data type. 

Such fields will always be displayed in the base currency. 

 

 Also display the following field on the card: The first row on each card can't be 

configured and is defined by the associated App Designer setting for the displayed 

data record type. For the second row, you may select between the App Designer 

configuration (default setting 2. row) and fields of the data record type. 

 Use the following field for the color classification: Select a color classification 

field and colors for field values here. The selection includes all fields with input help 

items as well as combinations of Type and Status, if available. 

 Use the following field for the user picture: Select here a user field to display 

the picture of the associated employee address on each card. For addresses, you 

may also select Picture from address. 

6.1.5 Filter 

 Here you edit the filter for the list, board, report and timeline views. Unsaved changes 

will be temporarily retained when switching between these views. However, when you 

reopen the list view out of the app start, the filter will be reset.  

You can save changes you made to filter settings for your own views by clicking on  

Save changes. Changes made to filter settings of public views can only be saved in 

the associated navigator in the Desktop Client. 
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6.1.6 Interactions 

The Board view supports the following interactions. 

 Open data record for editing by left-clicking on the pen on a card. 

 Open radial menu by right-clicking on a card. 

 Change field value (group) by dragging a card to another column and dropping it. 

 Create data records by clicking on the plus button. 
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6.2 Timeline view 

The following sections briefly outline the availability, visualization and features of the 

Timeline view, which is available in CAS genesisWorld Web with Report. 

 6.2.1 Licensing (page 82) 

 6.2.2 General (page 82) 

 6.2.3 View menu (page 83) 

 6.2.4 Properties (page 84) 

 6.2.5 Time unit and start date (page 84) 

 6.2.6 Filter (page 84) 

 6.2.7 Interactions (page 85) 

6.2.1 Licensing 

When Report, Project or Helpdesk is licensed, the Timeline view is available in the Web 

Client (for Project and Helpdesk, activation in the Mangement Console isn’t required). 

6.2.2 General 

The Timeline view displays the chronological order of data records with a start and finish. 

 

With either of the associated licenses, you may open the view out of saved list views for 

any type of data records with a start and finish. 

Other than the standard data record types with a start and finish in CAS genesisWorld, the 

view will display any data record type with date fields named START_DT and END_DT. 

 To open a Timeline view for the data records displayed in a saved list view, open the 

View menu and select the Timeline view option. 
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Notes 

This feature is only available for saved list views listed under Views in the associated 

app. It isn't available for combined list views, list views with a link filter or list views that 

are currently filtered via the Search... field. 

The opened view always includes all data records from the list view. Selecting data 

records via the checkboxes in the first column has no effect. 

All settings, except for filter conditions, are automatically saved per list view and user 

and will be restored when next opening the view. 

For your own views, click on Save changes to save changed filter conditions. For public 

views, you can only save changes made to filter settings in the associated Desktop 

Client navigator. Unsaved changes made to filter conditions will be temporarily retained 

when switching between the list, board, report and timeline views. Reopening the 

associated list view out of the app start resets the filter. 

 

6.2.3 View menu 

 Via the View menu, you can switch to one of the following views: 

 Board view 

 Map view 

 Report view 
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6.2.4 Properties 

 In the Timeline view, you can edit the following Properties. 

 Visibility of weekends and Working hours to be displayed: Here you determine 

whether weekends will be displayed and how many hours per day will be displayed 

in the days view. 

 Data records that are completely within hidden periods won’t be displayed. 

 Data records with only the start or end in a hidden period will be displayed, but 

changing the hidden start or end and moving such records via drag-and-drop 

won’t be possible. 

 Number of columns in day, week and month view. 

 Use field for the grouping 

 All fields with input help items except Status for data records with the Type 

and Status fields. The Status of opportunities is available for selection as it 

doesn't depend on a Type field. 

 User fields: Person responsible (projects and opportunities),  Deputy 

(projects), Processed by (tasks), Employee, Team, Responsible employee, 

Responsible team (tickets). 

 Use field for the color classification and select colors for field values: any field 

with input help items as well as combinations of Type and Status, if available. 

6.2.5 Time unit and start date 

 Here you select the view’s time unit, Days, Weeks or Months. 

 Here you select the view’s start date, week or month in the calendar. Alternatively, 

click on Today to switch to the current date, week or month or click on a date, week 

or month in the timeline to switch to that period (depending on your display period). 

6.2.6 Filter 

 Here you edit the filter for the list, board, report and timeline views. Unsaved changes 

will be temporarily retained when switching between these views. However, when you 

reopen the list view out of the app start, the filter will be reset.  

You can save changes you made to filter settings for your own views by clicking on  

Save changes. Changes made to filter settings of public views can only be saved in 

the associated navigator in the Desktop Client. 
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6.2.7 Interactions 

The Timeline view supports the following interactions. 

 Expand or collapse group with the arrow button on a group. 

 Expand or collapse all with the down and up arrow buttons above the list. 

 Expand or collapse header column with the left or right arrow button above the list. 

 Open data record for editing or viewing by left-clicking on a bar. 

 Change start and/or finish via drag-and-drop. Drag the left or right edge of a bar to 

change the start or end. Drag a bar to move the data record. 

Please note the drag-and-drop limitations described for Visibility of weekends and 

Working hours to be displayed in the previous section. 

 Create data records with the plus button or by selecting a period with the mouse 

while holding the left mouse button. Not supported for all data record types. 
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7 Using customer dashboards 

Customer dashboard reports are only available in the Desktop Client. 

Use customer dashboard reports to process and clarify information from data records. 

 

 Fields of the data record 

 Measures from linked data records: You select linked data records by data record 

type, filter condition and link types. Number and time fields are available as measures. 

As calculation functions, the sum (except for dates and times), maximum, minimum and 

average are available. 

 Lists of linked data records: You specify linked data records via the data record type, 

filter condition and link types. 

 Links to external applications: You can open external applications directly from the 

customer dashboard. Fields of the associated data record (e.g., the address), can be 

passed to the application as parameters. 

 Columns and groups: You structure report items in groups with different headings. 

Lists of linked data records are displayed as groups of their own. The groups can be put 

together in columns. 
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7.1 Creating and editing definitions 

You configure customer dashboard reports in the Miscellaneous area of the Management 

Console, under Dashboards > Customer dashboard. 

In the Definition tab, you create customer dashboard definitions. 

In the Assignment tab, you assign your definitions to the desired data record windows.  

 

 New: Here you create a new definition. 

 Edit: Here you edit the selected definition. Alternatively, you edit a definition by 

double-clicking on the associated list entry. 

 Remove: Here you delete the selected definition. 

 Import: Here you import customer dashboard definitions from an XML file. Specify the 

desired file name and click Load file. Select the definitions you wish to import in the list 

and click OK. Existing definitions are not overwritten during the import. 

 Export: Here you export customer dashboard definitions to an XML file. Specify the 

desired file name. Select the definitions you wish to export in the list and click OK. The 

definitions are written into the target file. If you specify an existing file, it will be 

overwritten during the export. 
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7.1.1 Defining a customer dashboard 

You edit customer dashboard definitions in the Define customer dashboard window. 

 

 Data record type: Select the data record type of the report’s core data record here. 

The fields and links of the core data record form the report data. 

Customer dashboard reports can be displayed in the core data record’s window as well 

as in any unambiguosly linked data record like phone calls for an address (see "7.2 

Assigning definitions to data record windows" on page 93). 

 Fields: Select the fields for the list in the upper report section here. 

For new customer dashboard definitions, the fields of the Standard (public) view 

format for the selected data record type are initially selected. 

Please note: For addresses, the Form of address, First name and Name fields will only 

be displayed if you select all three and will be combined into the Contact person field. 

 Here you overwrite the selected fields with the fields of the Standard (public) view 

format for the selected data record type. 

 Title: Enter the default title for the generated reports here. In the assignment of a 

report to other data records, the title stated here can be replaced by another title. The 

report’s title is displayed as the label of the associated tab in the data record window. 

 Columns: Here you see the number of columns used to display the report items. 

 Stylesheet: If desired, specify an alternative XSL stylesheet to format the report here. 

 Include links: Here you create and edit an arbitrary number of report items and 

assemble them in groups and columns. 
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7.1.2 Editing report items 

You assemble report items in columns and groups or delete items in the following way.  

 Add column: Click New. Select New column and click on OK. 

 Add group: Click New. Select New group and click OK. 

Enter a description for the new group and click OK to confirm. 

 Assign report item to a column or group: Using the arrow buttons you specify the 

group and column of each report item. 

 Delete report item: Click here to delete the selected report item. 

7.1.3 Inserting a measure or link list 

You insert a new measure or link list in the following way. 

 Click on the New button in the toolbar for report items. 

 Select New measure or link list and click on OK. 

 Enter all information for the measure or list in the Edit measure or link list window as 

described in the following section. 
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 Linked data records: Here you make all settings for the linked data records and the 

link types to be regarded. 

 Data record type: Select the data record type of the linked data records here. 

 Preview: Here you open a list of the core data records currently selected with the 

settings Data record type, Filter and Participants. 

 Filter: Here you select filter conditions to further limit the selected data records, 

(e.g., Sector is equal to banking). 

 Participants: Here you select the users whose data records are included in the 

analysis when analyzing user sensitive data record types. 

 Link types: Here you select the desired link types. In the default setting, all link 

types that can be analyzed are selected. 

In the All link types mode, primary links are not regarded. 

Select the Only primary links option to include any data records in the analysis that 

are directly or indirectly linked to a core data record via a primary link. 

For example, in an analysis of time records linked to addresses in Only primary 

links mode, time records created for an appointment which has a primary link to a 

selected address are also regarded. 

 Title: Enter a description for the measure or detail view here. 

 Measure: With this option a measure is calculated from the linked data records and 

displayed as a single item. If you select Detail view instead, the linked data records 

are displayed in a list as an own group. 

 Detail list available: Here you add a link to the data record window or list. If only 

one data record is included in the analysis, the link opens it in the data record 

window. Multiple linked data records are displayed in a list instead. You select the 

view format in the View format menu under Detail view. 

 Use SQL measure: Select this option to specify an SQL query file instead of 

defining a measure using the Field and Function menus. 

The GGUID, VALUE and TABLENAME fields must be present: SELECT TOP 1 

NULL AS GGUID, NAME AS VALUE, NULL AS TABLENAME FROM 

ADDRESS0 WHERE NAME IS NOT NULL 

To link to the original record the customer dashboard belongs to, use the 

#ROOTGUID# variable: SELECT #ROOTGUID# AS GGUID, NAME AS VALUE, 

NULL AS TABLENAME FROM ADDRESS0 WHERE ADDRESS0.GWCOMPANYGUID 

= #ROOTGUID# 

To refer to a different database (provided it uses the same database server as the 

CAS genesisWorld database), use the following syntax: SELECT TOP 1 NULL 

AS GGUID, <field> AS VALUE, NULL AS TABLENAME FROM <database 

name>..<table name> WHERE <condition> 
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 Field: In the default setting, the <Count> option is selected here, causing the 

number of linked data records to be displayed. All fields in which a number, time 

of day, date, duration or working time is stored, are also available here. In the 

Function menu you select the calculation function Sum, Maximum, Minimum 

or Average. 

 Grouping: Select this option if the calculated measures should be grouped by 

another field of the linked data records. In this case, select the desired group field 

from this menu. 

 Unit: Here you specify the quantity unit to display, if desired. 

Predefined field formats are applied automatically. 

 Link list: Select this option if a list of the linked data records should be displayed 

instead of a measure. 

 View format: Select the desired view format for the list here. 

 Companies and contact persons: If you have selected addresses as core data records 

or as linked data records, you determine here whether a company and associated 

contact persons should be treated as one address in the link analysis. 

 Normal: The default setting considers only links of explicitly selected addresses. 

 Do not include contact partner links: This setting includes links to selected 

companies and to companies of selected contact persons. Links to contact persons 

are not considered. 

 Company dossier: This setting includes links to contact persons and companies 

which were not explicitly selected if they can be associated with a selected address. 

7.1.4 Adding a field 

You insert a new field in the following way. 

 Click on the New button in the toolbar for report items. 

 Select New field and click on OK. 

 Select the desired field in the associated menu. 

 If the field should be marked with a quantity unit in the report, activate the Unit option 

and enter the desired description in the associated field. 

Predefined field formats are applied automatically. 

 Insert the field by clicking OK. 
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7.1.5 Adding a program link 

Add a new program link in the following way. 

 Click on the New button in the toolbar for report items. 

 Select the Executable program option and click on OK. 

 The Edit program properties window opens. Enter the following settings here. 

 Program title: Enter the description to be displayed here. 

 Executable: Specify the path to the executable file here. Put quotation marks 

around the path if it contains spaces. 

 Parameter: Enter the desired paramaters here. If desired, include fields of the 

associated data record. By clicking Test parameters, you test whether the fields 

entered are actually available in the associated data records. 

 Insert the program link by clicking OK. 
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7.2 Assigning definitions to data record windows 

In the Assignment tab, under Customer dashboard, you assign customer dashboard 

definitions to data record types. 

A distinction is also made between entries in the Type field of the data records. You can 

define available items via an input help in the Database area of the Management Console. 

 

 New: Here you define a new assignment. It assigns a customer dashboard definition to 

a certain data record type and a certain selection of types that are applicable for a data 

record type. 

 Edit: Here you open the selected assignment. Alternatively you open an assignment by 

double-click. 

 Remove: Here you delete the selected assignment. 

You edit the assignment of a definition to data record windows in the Assign customer 

dashboard window. 
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 Data record window: Here you select the data record window the report should be 

displayed in. 

 Types: Select here the types for which the report should be displayed. Select the All 

option to select all types at once. Deselect the All option to deselect all types at once. 

 Data record: Select the core data record of the report here. 

By default, the Personal option is selected, which creates the report for the data record 

on which it is displayed (selected Data record window). 

If link types of the cardinality 1:1 or n:1 are available for the selected data record type, 

the linkable data records are available for selection in the Data record menu. 

 Definition: Here you select the customer dashboard definition. Which definitions are 

available depends on your selection in the Data record menu. 

 Position: Here you specify the position of the customer dashboard tab in the data 

record window. 

 Before General (far left) 

 After General 

 Before Dossier 

 After Dossier (far right) – default setting. 

 Title: The title of the customer dossier definition is automatically uses as the label of 

the tab which displays the report in the data record window. Activate the Title option 

to specify a different title. 
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8 Management Console settings 

The following sections describe the Management Console settings for the Report module.  

 8.1 Settings in the Rules area (page 95) 

 8.2 Settings in the Miscellaneous area – Currencies (page 96) 

8.1 Settings in the Rules area 

To send reports, you need to set up the notification and action service, including the 

associated e-mail account, and the service needs to be running 

Enter these settings under Server settings in the Rules area of the Management Console. 

 

For more information about setting up the service and e-mail account, see the online help 

for the Management Console. Open it via the Help menu or the [F1] key. 
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8.2 Settings in the Miscellaneous area – Currencies 

You may enter currencies in the Miscellaneous area, under Currencies.  

All list items will be available for selection in all currency fields in CAS genesisWorld. 

You also determine the system's Base currency here. 

This is the presetting for currency fields in CAS genesisWorld. 

To convert foreign currencies to the base currency in reports, in formula fields and in 

board views in CAS genesisWorld Web, enter conversion rates here. 

Enter the conversion rate from the base currency to any foreign currency to convert as 

Exchange ratio Euro to Currency, regardless of which currency you are using as base 

currency. For example, if you are using GBP as base currency and wish to convert CHF, edit 

CHF and enter the conversion rate for GBP to CHF (e.g., if 1 GBP = 1.2 CHF, enter 1.2). 

For the base currency itself, enter 1 as Exchange ratio Euro to Currency. 

 

Please note that you can no longer change the Base currency after selecting the 

Maintain different prices for products option under Miscellaneous > Products. 
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9 Data types in the formula editor 

The following chapter give an overview on the data types supported in the formula editor. 

9.1 Supported data types 

The following data types are supported in the formula editor. 

Data type in formula editor Data types in CAS genesisWorld 

Float (floating point number) decimal, float, money 

Integer bigint, int, smallint, tinyint 

Boolean value bit 

String char/nchar, varchar/nvarchar 

nvarchar Date/Time datetime 

The binary and varbinary data types are not supported. 

Some standard binary ID fields type such as "Record ID" are available for use in formulas. 

These fields are automatically converted to strings in hexadecimal notation when used. 

9.2 Float (floating point number) 

Floating point numberes support a larger value range than integers, but are only precise 

for up to 15 digits total, including digits before and after the floating point (e.g., 7 digits 

before and 8 digits after the point). 

The number of decimal places in a database field or a calculated field depends on the 

respective settings. 

When entering floating point numbers, the period (".") is always used as decimal 

separator. 

Thousands separators aren’t supported in input values. 

 Example: 1999.99 

 Range: 2.23E-308 to 1.79E+308 

 Maximum precision: 15 digits 

9.3 Integer 

Calculations with the Integer result type always yield an integer (e.g., 1/3 = 0). 

Therefore, use the Float type for calculations that may return non integer values. 

Thousands separators aren’t supported in input values. 

 Example: 1250 

 Range: -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807 
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9.4 Boolean value 
Boolean values are encoded with true and false, without quotes. 

9.5 String 

The following rules apply to strings in the formulat editor: 

 String constants must be put in double quotes (e.g., "String"). 

 Concatenate string fields and constants with "+" (e.g., {Field} + "String") 

 Special characters (", \) must be preceded by a backslash character (\) if they should 

be part of the string (e.g., "\"Quote\"" or "C:\\Users"). 

 Line breaks can be inserted with "\n" (e.g., "Line1\nLine2"). 

9.6 Date/Time 

The Date/Time data type supports fields and functions of that type. You can find available 

functions under Date and time and under Type conversion. If you want to enter a date, 

use the EncodeDate or StringToDate functions. 

Fields of the Date/Time type are internally represented as floating point numbers, the 

part before the point encoding the date and the part after the point encoding the time of 

day as a proportion of 24 hours. You can therefore calculate with Date/Time values (e.g., 

{Field} – 1 subtracts a day and {Field} + 8/24 adds eight hours). 

CurrentDate() returns the current date and CurrentTime() returns the current 

time of day. To combine both, convert the time to a floating point number and add: 

CurrentDate() + ToFloat(CurrentTime()). 
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10 Functions in the formula editor 

The following chapter describes functions available in the formula editor. 

10.1 Available functions (Maths) 

The following mathematical functions are available in the formula editor. 

Note 

If you use Truncate or Round in a calculated field, then display that field in the report 

view and group the values by another field, Truncate or Round will be applied to each 

data record in the group before calculating the group sum. 

10.1.1 Truncate(Number, Decimal places) 

This function truncates the specified number up to the specified decimal places. 

 Input parameters 

 Number (floating point number): the number to truncate 

 Decimal places (integer): the number of decimal places to remain 

 Output: number truncated to the specified decimal places (floating point number) 

Example 

Truncate (123.4567, 3)  123.456 

10.1.2 Round(Number, Decimal places) 

This function rounds the specified number to the specified decimal places. 

 Input parameters 

 Number (floating point number): the number to round 

 Decimal places (integer): the number of decimal places to remain 

 Output: number rounded to the specified decimal places (floating point number) 

Example 

Round (123.4567, 3)  123.457 

10.1.3 Power(Number, Number) 

This is the power function with arguments base and exponent.  
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Please note that the calculation with very large numbers as arguments, particularly as 

exponent, can cause a memory overflow in the client. 

 Input parameters 

 Number (floating point number): base. 

 Number (floating point number): exponent. 

 Output: base to the power of exponent. 

Example 

Power(1.1, 3)  1.331 

10.1.4 Log(Number) 

This function returns the natural logarithm of the specified number. 

Use the formula log(x)/log(y) to calculate the logarithm of x with base y. 

 Input parameters 

 Number (floating point number): number whose natural logarithm to return 

 Output: natural logarithm of the specified number (floating point number) 

Example 

Log(100)/Log(10)  2 
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10.2 Available functions (Strings) 

The following string functions are available in the formula editor. 

10.2.1 Length(String) 

This function returns the length of the string. 

 Input parameter 

 String: the string whose length is to be determined 

 Output: length of the specified string (integer) 

Example 

Length("Hello")  5 

10.2.2 Trim(String) 

This function cuts off blanks at the beginning and end of the string. 

 Input parameter 

 String: the string to be trimmed 

 Output: the specified string without blanks at the beginning and end (string) 

Example 

Trim("   Hello   ")  "Hello" 

10.2.3 LowerCase(String) 

This function transforms all capital letters in the string to lower case. 

 Input parameter 

 String: the string to be transformed 

 Output: the specified string in lower case (string) 

Example 

LowerCase("Hello")  "hello" 
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10.2.4 UpperCase(String) 

This function transforms all small letters in the string to upper case. 

 Input parameter 

 String: the string to be transformed 

 Output: the specified string in upper case (string) 

Example 

UpperCase("Hello")  "HELLO" 

10.2.5 Left(String, Length) 

This function returns the first length characters of the string. 

 Input parameters 

 String: the string to be trimmed 

 Length (integer): length of the string to return 

 Output: the first length characters of the specified string (string) 

Example 

Left("Hello", 3)  "Hel" 

10.2.6 Right(String, Length) 

This function returns the last length characters of the string. 

 Input parameters 

 String: the string to be trimmed 

 Length (integer): length of the string to return 

 Output: the last length characters of the specified string (string) 

Example 

Right("Hello", 3)  "llo" 
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10.2.7 Replace(Input string, Search string, Replace string) 

This function replaces each occurrence of a string by another string in a string to be 

searched. The search is not case sensitive. 

 Input parameters 

 Input string: the string to search 

 Search string: the string to replace 

 Replace string: the string to insert 

 Output: input string, where each occurrence of search string has been replaced by 

replace string (string) 

Example 

Replace("FOOfoo", "foo", "bar")  "barbar" 

10.2.8 Search(Input string, Search string) 

This function returns the first position of a string in a string to be searched. The search is 

not case sensitive. 

 Input parameters 

 Input string: the string to search 

 Search string: the string to look for 

 Output: first position of search string in input string or 0 if search string is not contained 

in input string (integer) 

Example 

Search("Hello World", "world")  7 



Report   Functions in the formula editor 

104 

10.2.9 Contains(Input string, Search string) 

This function specifies whether one string is contained in another one. The search is not 

case sensitive. 

 Input parameters 

 Input string: the string to search 

 Search string: the string to look for 

 Output: true, if Input string is contained in Search string, false otherwise (boolean 

value). 

Example 

Contains("Hello World", "world")  true 

10.2.10 Substring(String, Start, Length) 

This function partially returns a given String. 

 Input parameters 

 String: the string to be searched 

 Start (integer): first character to return 

 Length (integer): number of characters to return 

 Output: the string starting at Start with length Length which is contained in the input 

string (string). 

Example 

Substring("Hello World", 7, 5)  "World" 
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10.3 Available functions (Date and time) 

The following functions are available in the formula editor to process dates and times. 

Note 

In the examples featuring the CurrentDate() and CurrentTime() functions, Wednesday, 

2/15/2023 is used as current date and 08:32:57 am is used as current time. 

Please also note sections "10.6.6 DateToString(Date/Time, Output format)" and "10.6.7 

StringToDate(String, Input format)" on page 118 for date/string conversion. 

10.3.1 CurrentDate() 

This function returns the current date. No time is returned. 

 Output: Current date (date/time) 

Example 

CurrentDate()  2/15/2023 00:00:00 

10.3.2 CurrentTime() 

This function returns the current time. No date is returned. 

 Output: Current time (date/time) 

Example 

CurrentTime()  12/30/1899 08:32:57 

10.3.3 YearOf(Date/Time) 

This function returns the year in a date as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: year (integer) 

Example 

YearOf(CurrentDate())  2023 
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10.3.4 MonthOf(Date/Time) 

This function returns the month in a date as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: month (integer) 

Example 

MonthOf(CurrentDate())  2 

10.3.5 MonthName(Date/Time) 

This function returns the name of a month in a date. 

The Desktop Client uses the client language. 

The Web Client uses the server language. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: name of month (string) 

Example 

MonthName(CurrentDate())  "February" 

10.3.6 DayOfTheMonth(Date/Time) 

This function returns the day of the month in a date as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: day of the month (integer) 

Example 

DayOfTheMonth(CurrentDate())  15 
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10.3.7 DayOfTheWeek(Date/Time) 

This function returns the week day in a date as a number. The number 1 stands for 

Monday. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: week day (integer) 

Example 

DayOfTheWeek(CurrentDate())  3 

10.3.8 WeekDayName(Date/Time) 

This function returns the name of the week day in a date. 

The Desktop Client uses the client language. 

The Web Client uses the server language. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: name of week day (string) 

Example 

WeekDayName(CurrentDate())  "Wednesday" 

10.3.9 HourOfTheDay(Date/Time) 

This function returns the hours in a time of day as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: hours (integer) 

Example 

HourOfTheDay(CurrentTime())  8 
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10.3.10 MinuteOf(Date/Time) 

This function returns the minutes in a time of day as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: minutes (Integer) 

Example 

MinuteOf(CurrentTime())  32 

10.3.11 SecondOf(Date/Time) 

This function returns the seconds in a time of day as a number. 

 Input parameter 

 Date/Time: date/time value to process 

 Output: seconds (integer) 

Example 

SecondOf(CurrentTime())  57 

10.3.12 AddDay(Date/Time, Number) 

This function adds the specified number of days to the input date. 

 Input parameters 

 Date/Time: date/time value to process 

 Number(Integer): number of days to add 

 Output: input date plus number of days (date/time) 

Example 

AddDay(CurrentDate(), 1)  2/16/2023 00:00:00 



Report   Functions in the formula editor 

109 

10.3.13 AddMonth(Date/Time, Number) 

This function adds the specified number of months to the input date. 

 Input parameters 

 Date/Time: date/time value to process 

 Number(Integer): number of months to add 

 Output: input date plus number of months (date/time) 

Example 

AddMonth(CurrentDate(), 1)  3/15/2023 00:00:00 

10.3.14 AddYear(Date/Time, Number) 

This function adds the specified number of years to the input date. 

 Input parameters 

 Date/Time: date/time value to process 

 Number(integer): number of years to add 

 Output: input date plus number of years (date/time) 

Example 

AddYear(CurrentDate(), 1)  2/15/2024 00:00:00 

10.3.15 AddInterval (Date/Time, Interval) 

This functions adds the interval specified as a string to the input date. 

In English, supported strings are Month, Quarter, Half year and Year. In other client 

languages, corresponding translations must be passed to the function. This can be done 

via a field with an international input help, like the Bill per service agreement field. 

The strings accepted in a client language are displayed in the formula editor in the hint for 

this function when running the client in that language. 

 Input parameters 

 Date/Time: date/time value to process 

 Interval(string): Month, Quarter, Half year or Year and translations 

 Output: input date plus interval. (date/time) 
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Example 

AddInterval(CurrentDate(), "Half year")  8/15/2023 00:00:00 

10.3.16 EncodeDate(Year, Month, Day) 

This function returns a date. 

 Input parameters 

 Year(integer) 

 Month(integer) 

 Day(integer) 

 Output: date from year, month and day (date/time) 

 Limitations 

 Dates before 1753 cannot be created. 

 The year must be specified with four digits. 

 Faulty input results in NULL return value. 

Examples 

EncodeDate(2023, 2, 15)  2/15/2022 00:00:00 

EncodeDate(23, 2, 15)  NULL 
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10.4 Available functions (More) 

The following functions are available to test for NULL, for reading in the user name and 

operating language, to test whether a user is in a given group and to convert values 

between currencies. 

10.4.1 IsNull(Value) 

This function specifies if a given value is NULL. The tested value may have any data type. 

With this function, you can determine whether a specific link from an aggregated sub-

query is present in a data record. To do this, test whether the Record ID field is NULL in 

the sub-query. If that is not the case, a linked data record exists. 

 Input parameter 

 Value (any data type): the value to test 

 Output: true if the value to test is NULL, false otherwise (boolean value). 

Example 

IsNull({Receipts.Net amount}) OR {Receipts.Net amount} = 0 

 true if no net amount had been entered, false otherwise. 

NOT IsNull({Addresses.Record ID}) ["Addresses" is an aggregated 

sub-query] 

 true if a linked address exists, false otherwise. 

10.4.2 NULL() 

This function returns the NULL value. 

 Output: NULL (data type of the return value of the formula) 

Example 

IsNull(NULL())  true 

10.4.3 CurrentUser() 

This function returns the user name of the current user. 

 Output: user name of the current user (string) 

Example 

CurrentUser()  "Peter Grayhound" 
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10.4.4 UserNameForId(User ID) 

This function takes the ID of an employee’s address and returns the associated user name- 

 Input parameter 

 User ID (string): ID of an employee’s address 

 Output: User name of the user associated with the employee’s address. For addresses 

that haven’t been associated with a user, the function returns the NULL value. 

Example 

UserNameForId({Addresses.User ID})  "Peter Grayhound" 

10.4.5 IsCurrentUserInGroup(Group) 

This function specifies whether the current user is a member of the given group. 

The group name can be prefixed with the domain, separated by a double backslash 

character (e.g., "Domain\\Group"). The local domain can be specified without the domain 

name by prefixing the group with only a double backslash (e.g., "\\Group"). When the 

domain is not specified, the condition is considered as satisfied if a group with the 

specified name in which the current user is a member exists in any domain. 

 Input parameter 

 Group (string): The group to test, optionally with domain name (see above). 

 Output: true if the current user is a member of the group, false otherwise 

(boolean value). 

Examples 

IsCurrentUserInGroup("Sales")  true 

IsCurrentUserInGroup("\\Sales")  true 

IsCurrentUserInGroup("Liverpool\\Sales")  true 

10.4.6 CurrentLanguage() 

This function returns the operating language as a two character ISO Code. 

 Output: operating language (string) 

Example 

CurrentLanguage()  "en" 
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10.4.7 ToBaseCurrency(Value, Currency) 

This function converts the specified value from the specified original currency to the base 

currency. 

 Input parameters 

 Value (floating point number): The value to convert 

 Currency (string): three character ISO code of the original currency 

 Output: Value, converted from the original currency to the base currency (floating 

point number) 

Example 

ToBaseCurrency (100, "USD")  76.99 

10.4.8 FromBaseCurrency(Value, Currency) 

This function converts the specified value from the base currency to the specified target 

currency. 

 Input parameters 

 Value (floating point number): The value to convert 

 Currency (string): three character ISO code of the target currency 

 Output: Value, converted from the base currency to the target currency (floating point 

number) 

Example 

FromBaseCurrency (100, "USD")  129.86 

 

Note concerning the currency functions 

Specify currencies with the three character ISO code, as always in CAS genesisWorld. 

Enter currencies and conversion rates under Currencies in the Miscellaneous area of 

the Management Console, (see "8.2 Settings in the Miscellaneous area – Currencies" on 

page 96). 
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10.5 Available functions (Working time) 

The WorkingTimeForUser function calculates the given user’s working time in the 

given period, excluding the end date, in 24h days. 

10.5.1 WorkingTimeForUser(User ID, Start date, End date) 

This function calculates the given user’s working time in the given period, including the 

end date, in 24h days. 

 Input parameters 

 User ID (string): The desired user’s GUID. It will be available as an address field if 

addresses have been selected. Instead of the GUID, you may also specify the user 

name. 

 Start date (date/time): Start date (time of day is ignored, working time calculation 

always includes the full day of the specified start date). 

 End date (date/time): End date (time of day is ignored, working time calculation 

always includes the full day of the specified end date). 

 Output: The given user’s total working time in the given period, including the end date, 

in 24h days (floating point number) 

Example 

WorkingTimeForUser({Addresses.User ID}, {Addresses.Hiring date}, 

{Addresses.Leaving date})  142.5 

 

Note 

For all-day appointments, the end is internally stored as 00:00 hours of the day 

following the end displayed for the appointment. 

To determine the working time during an all-day appointment, one day should 

therefore be subtracted from the end date. 

This can be achieved by {Appointment.End} - 1. 
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10.6 Available functions(Type conversion) 

The following type conversion functions are available in the formula editor. 

10.6.1 ToString(Value) 

This function transforms any value to a string. 

 Input parameter 

 Value(any data type): the value to transform 

 Output: value (string) 

 Details 

 Boolean values will be converted to "Yes" or "No".  

 Dates will be encoded in the format "dd.mm.yyyy". Use DateToString to specify a 

custom format (see "10.6.6 DateToString(Date/Time, Output format)" on page 118).  

 Floating point numbers will be rounded to two decimals.  

Examples 

ToString(true)  "Yes", ToString(false)  "No" 

ToString(CurrentDate())  "15.02.2023" 

ToString(1/8)  "0.13" 

10.6.2 ToInt(Value) 

This function transforms any value to an integer. 

 Input parameter 

 Value(any data type): the value to transform 

 Output: value (integer) 

 Limitations and Details 

 The decimal separator and thousands separator set up in Windows will be accepted 

as input when correctly used in a string. Strings that aren't numbers will return NULL. 

 Decimal places in input values will be cut off. 

 Input outside the valid range of numbers will result in wrong results. Floating point 

numbers support a larger range but have a lower precision (see page 97). 

 Strings that are not numbers and NULL will result to a NULL return value. 

 Boolean values will be converted to 1 or 0. 

 ToInt(date/time) returns the days since 12/30/1899. 
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Examples 

ToInt(23.456)  23 

ToInt("1,423.21")  1423 

ToInt(true)  1, ToInt(false)  0 

ToInt("foo"); ToInt(NULL())  NULL 

10.6.3 ToFloat(Value) 

This function transforms any value into an integer. 

 Input parameter 

 Value(any data type): the value to transform 

 Output: value (floating point number) 

 Limitations and Details 

 The number of decimal places in a database field or a calculated field depends on 

the respective settings. 

 The decimal separator and thousands separator set up in Windows will be accepted 

as input when correctly used in a string. 

 Input outside the valid range of numbers will result in wrong results. Integers 

support a higher precision but have a smaller range (see page 97). 

 Strings that are not numbers and NULL will result to a NULL return value. 

 Boolean values will be converted to 1.0 or 0.0. 

 ToFloat(date/time) returns the days since 12/30/1899, including the time as a 

fraction of a day after the floating point. 

Examples 

ToFloat(23)  23.00 

ToFloat("1,423.21")  1423.21 

ToFloat(true)  1.00, ToFloat(false)  0.00 

ToFloat("foo"); ToInt(NULL())  NULL 



Report   Functions in the formula editor 

117 

10.6.4 StringToFloat(String, Thousands seperator, Decimal 

seperator) 

This function transforms a string to a floating point number. 

 Input parameters 

 String: The string to transform 

 Thousands separator: The character to use as thousands separator 

 Decimal separator: The character to use as decimal separator 

 Output: The number contained in the string (floating point number) 

 Limitations and Details 

 "€" and "$" will only be accepted behind a sequence of numbers and will be 

removed during conversion. 

 If no thousands separator and decimal separator are specified (empty string), the 

Windows settings are applied. 

 Faulty input results in a NULL return value. 

Examples 

StringToFloat("3.000,23", ".", ",")  3000.23 

StringToFloat("3,000.23$", ",", ".")  3000.23 

10.6.5 ToBool(Value) 

This function transforms any value to a boolean value. 

Any positive or negative integer or floating point numbers yield true. 0 yields false. 

If a string is specified, "true", "wahr", "1", "-1", "y", "yes", "j" and "ja" are each interpreted as 

true. "false", "falsch", "0", "n", "no" and "nein" are each interpreted as false. The 

interpretation is not case-sensitive. The strings don’t have to be lowercase. All other 

strings are interpreted as NULL. 

 Input parameter 

 Value (any data type except date/time): the value to transform 

 Output: value (boolean value) 

Examples 

ToBool(1); ToBool(-10.0); ToBool("-1"); ToBool("YES")  true 

ToBool(0); ToBool(0.0); ToBool("0"); ToBool("nein")  false 

ToBool("0.0"); ToBool("10"); ToBool(""); ToBool(Null())  NULL  
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10.6.6 DateToString(Date/Time, Output format) 

This function transforms a date or time of day value to a string. 

 Input parameters 

 Date/Time: date/time value to process 

 Output format (string): Formatting. You have the following options. Upper and 

lower case are not treated differently. 

 yy / yyyy: year with two or four digits 

 m / mm: month with one or two digits 

 d / dd: day with one or two digits 

 hh: hours, two digits only 

 nn: minutes, two digits only 

 ss: seconds, two digits only 

 Output: date/time (string) 

Examples 

DateToString(CurrentDate(), "m/d/yy")  "2/15/23" 

DateToString(CurrentDate(), "dd.mm.yyyy")  "15.03.2023" 

DateToString(CurrentTime(), "hh:nn")  "08:32" 

DateToString(CurrentDate() + ToFloat(CurrentTime()), "m/d/yyyy, 

hh:nn")  "2/15/2023, 08:32" 

10.6.7 StringToDate(String, Input format) 

This function transforms a string to a date/time value. 

 Input parameters 

 String: The String to transform 

 Input format (string): Formatting. You have the same options as for the 

DateToString function. Upper and lower case are not treated differently. 

 Output: date/time 

 Limitations 

 Dates before 1753 cannot be converted. 

 The input string must contain a date with a four digit year. 

 Faulty input results in a NULL return value. 
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Examples 

StringToDate("2/15/2023", "m/d/yyyy")  2/15/2023 00:00:00 

StringToDate("15.02.2023", "dd.mm.yyyy ")  2/15/2023 00:00:00 

StringToDate("2/15/2023 08:32:57", "m/d/yyyy hh:nn:ss") 

 2/15/2023 08:32:57 

StringToDate("2/15/23", "m/d/yy")  NULL 

StringToDate("08:32", "hh:nn")  NULL 

10.6.8 ToCurrencyString(Value) 

This function formats a number (integer or floating point) as a string indicating an amount 

of money. If required, the number will be rounded to two decimal places and thousands 

separators will be inserted. The decimal and thousands separator  

 Input parameter 

 Value (integer or floating point number): The value to format 

 Output: Value (string) 

Example 

ToCurrencyString(1999.999)  "2,000.00" 
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11 Operators in the formula editor 

The following chapter supplies an overview of available operators, their combination with 

different data types in the formula editor and the data types of associated result values. 

11.1 Overview of available operators 

The following operators are available in the formula editor. 

 Arithmetic: addition("+"), subtraction("-"), multiplication("*"), division("/") 

 Compare: is equal to("="), is unequal to("<>"), less than("<"), greater than(">"), less 

than or equal("<="), greater than or equal(">=") 

 Boolean: not("NOT"), and("AND"), or("OR") 

 Control element structures: "if then else" 

 Others: parentheses("(x)"), comments("//") 

11.2 Prefix operators 

Prefix operators precede the expression they are applied to. 

Prefix operators available in the formula editor are: 

 + (positive prefix, used for all numbers by default and can therefore be ommitted, e.g., 

5 equals +5) 

 - (negative prefix, e.g., -2.5) 

 NOT (logical negation, e.g., NOT {Addresses.is Company} results to true for 

company contacts and to false for companies and individual contacts) 

11.3 Infix operators 

Infix operators stand between two expressions they are applied to. 

The following infix operators are available in the formula editor. 

 Arithmetic operations are valid between integer and floating point numbers. The 

addition and subtraction also allow for date/time expressions. The plus sign "+" can 

also be used to concatenate strings (see pages 124 through 127). 

 + (addition, e.g., 0.5 + 7 results to 7.5) 

 - (subtraction, e.g., 10 - 2.5 results to 7.5) 

 * (multiplication, e.g., 2.5 * 4 results to 10) 

 / (division, e.g., 10 / 4 results to 2.5) 
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 Comparisons are valid between expressions of the same type as well as between 

integer numbers, floating point numbers and date/time expressions. For boolean 

expressions, only equality and unequality are valid (see pages 128 through 129). 

 = (is equal to, e.g., 1 + 1 = 2 results to true) 

 <> (is unequal to, e.g., 1 + 1 <> 3 results to true) 

 < (less than, e.g., 1 < 2 results to true) 

 > (greater than, e.g., 2 > 1 results to true) 

 <= (less than or equal to,  e.g., 1 <= 1 results to true) 

 >= (greater than or equal to, e.g., 1 >= 1 results to true) 

 Boolean operations are only valid for boolean expressions (see page 130). 

 AND (logical AND, e.g., this is true for individual contacts only; as companies and 

company contacts fail to fulfill both conditions, the statement is false for them: 

{Addresses.is Company} AND {Addresses.is Contact}) 

 OR (logical OR, e.g., this is true for all addresses receiving either a christmas or 

birthday card and false for addresses for which none of both boxes is checked: 

{Addresses.Birthday card} OR {Addresses.Christmas card}) 

11.4 Special operators 

Additionally, if/then/else, parentheses and comments are available: 

 If/then/else allows for logical branching, e.g., this expression returns the name for 

contact persons and individual contacts and the company name for companies: 

IF {Addresses.is Contact} THEN {Addresses.Name} ELSE 

{Addresses.Company} 

For case selection, you can nest such structures as deeply as you like, e.g.:  

IF {Opportunities.Probability} = 100 THEN 1 

ELSE IF {Opportunities.Probability} >= 50 THEN 0.5 

ELSE IF {Opportunities.Probability} >= 25 THEN 0.25 

ELSE 0 

 Parentheses control the order in which operators are applied. Additionally, the usual 

rules always apply, such as the precedence of multiplication and division over addition 

and subtraction. 

Use parentheses, for instance, to multiply a sum: 

({Contracts.Credit balance} + {Contracts.Funding amount}) * 1.03 

 Comments serve only for internal documentation purposes and are never evaluated. 

For instance, you could comment on the calculation in the previous item regarding 

parantheses as //Total +3% 
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11.5 Combining data types with operators 

The following sections inform you about which data types and operators may be 

combined in the formula editor. There are two tables for each operator. 

The first table "Formula editor" specifies which data types may be combined with the 

operator in the formula editor. 

The second table "Run time" specifies the data types of return values which result from the 

combination of data types with an operator. Here data types resulting from the 

combination with null values are also listed. 

11.5.1 Prefix operator "-" 

Formula editor 
Integer Yes 

Float Yes 

Date/Time - 

String - 

Boolean value - 

Run time 
Integer Integer 

Float Float 

Date/Time - 

String - 

Boolean value - 

Integer (Null) - 

Float (Null) - 

Date/Time (Null) - 

String (Null) - 

Boolean value (Null) - 

11.5.2 Prefix operator "+" 

Formula editor 
Integer Yes 

Float Yes 

Date/Time - 

String - 

Boolean value - 



Report   Operators in the formula editor 

123 

Run time 
Integer Integer 

Float Float 

Date/Time - 

String - 

Boolean value - 

Integer (Null) - 

Float (Null) - 

Date/Time (Null) - 

String (Null) - 

Boolean value (Null) - 

11.5.3 Prefix operator "NOT" 

Formula editor 
Integer - 

Float - 

Date/Time - 

String - 

Boolean value Yes 

Run time 
Integer - 

Float - 

Date/Time - 

String - 

Boolean value Boolean value 

Integer (Null) - 

Float (Null) - 

Date/Time (Null) - 

String (Null) - 

Boolean value (Null)* Boolean value 

* NOT NULL is true, NULL = false is false (see page 128). 
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11.5.4 Infix operator "+" 

Formula editor 
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Integer Yes Yes Yes - - 

Float 

umbernumber 

Yes Yes Yes - - 

Date/Time Yes Yes - - - 

String - - - Yes - 

Boolean value - - - - - 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Int Fl D/t - - Int Fl D/t(N) - - 

Float Fl Fl D/t - - Fl Fl D/t(N) - - 

Date/Time D/t D/t - - - D/t D/t - - - 

String - - - Str - - - - Str - 

Boolean value - - - - - - - - - - 

Integer(Null) Int Fl D/t - - Int(N) Fl(N) D/t(N) - - 

Float(Null) Fl Fl D/t - - Fl(N) Fl(N) D/t(N) - - 

Date/Time(Null) D/t(N) D/t(N) - - - D/t(N) D/t(N) - - - 

String(Null) - - - Str - - - - Str(N) - 

Boolean value(Null) - - - - - - - - - - 
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11.5.5 Infix operator "-" 

Formula editor 

-  In
te

g
e
r 

F
lo

a
t 

D
a
te

/T
im

e
 

S
tr

in
g

 

B
o

o
le

a
n

 v
a
lu

e
 

Integer Yes Yes - - - 

Float Yes Yes - - - 

Date/Time Yes Yes Yes - - 

String - - - - - 

Boolean value - - - - - 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Int Fl - - - Int Fl - - - 

Float Fl Fl - - - Fl Fl - - - 

Date/Time D/t D/t Fl - - D/t D/t Fl(N) - - 

String - - - - - - - - - - 

Boolean value - - - - - - - - - - 

Integer(Null) Int Fl - - - Int(N) Fl(N) - - - 

Float(Null) Fl Fl - - - Fl(N) Fl(N) - - - 

Date/Time(Null) D/t(N) D/t(N) Fl(N) - - D/t(N) D/t(N) Fl(N) - - 

String(Null) - - - - - - - - - - 

Boolean value(Null) - - - - - - - - - - 
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11.5.6 Infix operator "*" 

Formula editor 
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Integer Yes Yes - - - 

Float Yes Yes - - - 

Date/Time - - - - - 

String - - - - - 

Boolean value - - - - - 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Int Fl - - - Int(N) Fl(N) - - - 

Float Fl Fl - - - Fl(N) Fl(N) - - - 

Date/Time - - - - - - - - - - 

String - - - - - - - - - - 

Boolean value - - - - - - - - - - 

Integer(Null) Int(N) Fl(N) - - - Int(N) Fl(N) - - - 

Float(Null) Fl(N) Fl(N) - - - Fl(N) Fl(N) - - - 

Date/Time(Null) - - - - - - - - - - 

String(Null) - - - - - - - - - - 

Boolean value(Null) - - - - - - - - - - 
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11.5.7 Infix operator "/" 

Formula editor 
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Integer Yes Yes - - - 

Float Yes Yes - - - 

Date/Time - - - - - 

String - - - - - 

Boolean value - - - - - 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Fl Fl - - - Fl(N) Fl(N) - - - 

Float Fl Fl - - - Fl(N) Fl(N) - - - 

Date/Time - - - - - - - - - - 

String - - - - - - - - - - 

Boolean value - - - - - - - - - - 

Integer(Null) Fl(N) Fl(N) - - - Fl(N) Fl(N) - - - 

Float(Null) Fl(N) Fl(N) - - - Fl(N) Fl(N) - - - 

Date/Time(Null) - - - - - - - - - - 

String(Null) - - - - - - - - - - 

Boolean value(Null) - - - - - - - - - - 
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11.5.8 Infix operators "=" and "<>" 

Formula editor 
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Integer Yes Yes Yes - - 

Float Yes Yes Yes - - 

Date/Time Yes Yes Yes - - 

String - - - Yes - 

Boolean value - - - - Yes 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Bo Bo Bo - - Bo Bo Bo - - 

Float Bo Bo Bo - - Bo Bo Bo - - 

Date/Time Bo Bo Bo - - Bo Bo Bo - - 

String - - - Bo - - - - Bo - 

Boolean value - - - - Bo - - - - Bo 

Integer(Null) Bo Bo Bo - - Bo Bo Bo - - 

Float(Null) Bo Bo - - - Bo Bo Bo - - 

Date/Time(Null) Bo Bo Bo - - Bo Bo Bo - - 

String(Null) - - - Bo - - - - Bo - 

Boolean value(Null) - - - - Bo - - - - Bo 

Comparisons with NULL with these operators almost always result to false, except: 

 NULL = NULL is true. 

 [Any value except for NULL] <> NULL is true. 
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11.5.9 Infix operators "<", ">", "<=" and ">=" 

Formula editor 
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Integer Yes Yes Yes - - 

Float Yes Yes Yes - - 

Date/Time Yes Yes Yes - - 

String - - - Yes - 

Boolean value - - - - - 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Integer Bo Bo Bo - - Bo Bo Bo - - 

Float Bo Bo Bo - - Bo Bo Bo - - 

Date/Time Bo Bo Bo - - Bo Bo Bo - - 

String - - - Bo - - - - Bo - 

Boolean value - - - - - - - - - - 

Integer(Null) Bo Bo Bo - - Bo Bo Bo - - 

Float(Null) Bo Bo - - - Bo Bo Bo - - 

Date/Time(Null) Bo Bo Bo - - Bo Bo Bo - - 

String(Null) - - - Bo - - - - Bo - 

Boolean value(Null) - - - - - - - - - - 

Comparisons with NULL with these operators almost always result to false, except: 

 NULL <= NULL is true. 

 NULL >= NULL is true. 
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11.5.10 Infix operators "AND" and "OR" 

Formula editor 
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Integer - - - - - 

Float - - - - - 

Date/Time - - - - - 

String - - - - - 

Boolean value - - - - Yes 

Run time 

Int = Integer 

Fl = Float 

D/t = Date/Time 

Str = String 

Bo = Boolean value 

(N) = (NULL) 
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Float - - - - - - - - - - 

Date/Time - - - - - - - - - - 

String - - - - - - - - - - 

Boolean value - - - - Bo - - - - Bo 

Integer number(Null) - - - - - - - - - - 

Float(Null) - - - - - - - - - - 

Date/Time(Null) - - - - - - - - - - 

String(Null) - - - - - - - - - - 

Boolean value(Null) - - - - Bo - - - - Bo 
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